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This is a monthly deep audit. The crawler performed a full-site scan including

Lighthouse performance, axe-core accessibility (WCAG 2.2 AA), cross-browser compatibility,

security headers, schema markup validation, and SEO best-practice checks.

Because this site is not a repository we control, Apex Sentinel **cannot automatically

apply fixes** — instead, each finding below includes an AI-generated plain-English

explanation + step-by-step recommended fix you can hand to a developer or execute

in your CMS directly.

Executive Summary

Overall grade: F

DIMENSION COUNT MEANING

Pages crawled 166 Full sitemap + linked pages

P0 (critical) 1 Site-down or compliance-breaking

P1 (urgent) 4 Significant revenue / SEO / UX impact
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DIMENSION COUNT MEANING

P2 (high) 355 Quality / ranking / trust degradation

P3 (medium) 456 Polish + optimization

"Do first" items 5 AI-flagged top priorities

Quick wins (< 30 min) 38 Fastest ROI items

Top 10 Actions (Ranked)

If you only have time for ten things this month, do these — in this order.

1. [P0] 🔴  DO FIRST Sensitive artifact exposed: /wp-login.php — _An unauthorized admin account takeover

could expose customer data, allow malware injection, display illegal content, or take your dispensary offline

during peak sales hours—directly impacting revenue and compliance._

Page: https://greenleafwellness.com/wp-login.php

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST 120 broken internal link(s) — _Broken links waste customer intent—someone reading

your dispensary guide clicks 'shop now' and bounces instead of converting; you also lose SEO ranking

signals because search engines see these as poor site quality._

Page: https://greenleafwellness.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST A11y: ARIA dialog and alertdialog nodes should have an accessible name — _Visually

impaired customers cannot use your age gate, blocking legal access to your site. This creates legal liability

under the ADA and AAPA, and excludes a protected class of users._

Page: https://greenleafwellness.com/

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST A11y: Elements must meet minimum color contrast ratio thresholds — _Visitors with

visual impairments or color vision deficiency may miss critical messaging about account signup, reducing

conversions and creating potential legal liability under accessibility laws (ADA, AODA in Canada)._

Page: https://greenleafwellness.com/

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST A11y: Frames must have an accessible name — _Inaccessible embeds expose you to

ADA litigation risk, reduce organic search visibility (Google penalizes accessibility failures), and exclude

customers with disabilities from your site._

Page: https://greenleafwellness.com/

Effort: Quick win (< 30 min)
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1. [P2] 🟠  HIGH Missing meta description — _Missing meta descriptions reduce click-through rates from

Google search results; customers see an awkward snippet instead of your carefully-crafted message about

first-time dispensary visits, costing you qualified traffic._

Page: https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH Missing meta description — _Missing meta descriptions lower click-through rates from

search results because potential customers see a poor preview of your product, reducing traffic to a high-

intent product page._

Page: https://greenleafwellness.com/wyld-gummies/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH No JSON-LD schema — _Missing schema data reduces your visibility in search results and

prevents Google from showing product details (price, availability, reviews) that drive clicks and conversions,

especially important for cannabis retailers competing on local search._

Page: https://greenleafwellness.com/wyld-gummies/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH Missing meta description — _Missing meta descriptions reduce click-through rates from

search results; potential customers see a generic snippet instead of a compelling reason to visit your Bubba

Fett product page, directly costing you traffic and sales._

Page: https://greenleafwellness.com/bubba-fett-strain/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH No JSON-LD schema — _Without schema markup, your product pages rank lower in search

results, especially in local/map searches, and you miss opportunities to show rich snippets (star ratings,

pricing, in-stock status) that drive clicks._

Page: https://greenleafwellness.com/bubba-fett-strain/

Effort: Moderate (1-3 hours)

Findings by Severity

P0 — 1 finding

1. Sensitive artifact exposed: /wp-login.php

Severity: P0 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: security

Page URL: https://greenleafwellness.com/wp-login.php

Rule: tier5.exposed.artifact

What it means (plain English)
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Your WordPress login page (/wp-login.php) is publicly accessible and returns a successful response. This is a

standard WordPress file, but leaving it exposed makes your site an easy target for automated attacks trying

thousands of common passwords. Attackers can use bots to repeatedly attempt logins and potentially gain

unauthorized access to your admin panel.

Why it matters for your business: An unauthorized admin account takeover could expose customer data, allow

malware injection, display illegal content, or take your dispensary offline during peak sales hours—directly

impacting revenue and compliance.

Technical root cause: WordPress login endpoints are publicly accessible by default. While this is expected

behavior, the lack of additional protection (rate limiting, IP blocking, or alternative admin URLs) leaves the door

open to brute-force attacks at scale.

Recommended fix — step by step

1. Install Wordfence Security plugin (free version) → Dashboard → All Options → Brute Force Protection →

enable Rate Limiting, set max login attempts to 5 per 5 minutes

2. Go to Wordfence → Tools → IP Lockout → whitelist your office IP address(es) to prevent accidental lockout

3. Consider installing Limit Login Attempts Reloaded plugin as a lighter alternative if Wordfence feels

heavyweight

4. Enable two-factor authentication for all admin accounts: Users → Select Admin → scroll to 'Two-Factor

Options' or use Google Authenticator plugin

5. Change WordPress login URL from /wp-login.php to something random using WPS Hide Login plugin (one-

click rename, improves obscurity)

6. Add these lines to your .htaccess file (via SFTP or File Manager in cPanel) to rate-limit login attempts:

<FilesMatch "wp-login\.php"> Order Allow,Deny Allow from all </FilesMatch>
then install ModSecurity rules via hosting provider

7. Contact your hosting provider to confirm they have bot protection (Cloudflare, Sucuri, or native WAF)

enabled on your domain

P1 — 4 findings

1. 120 broken internal link(s)

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: revenue

Page URL: https://greenleafwellness.com/

Rule: tier2.links.broken

What it means (plain English)

Your site has 120 internal links pointing to pages that no longer exist (404 errors). This includes links in blog

posts like 'First Time Visiting a Dispensary in Nevada' pointing to /shop-pickup/, and product pages like 'Wyld

Gummies' with broken filter URLs. When visitors click these links, they hit dead ends, which frustrates

customers and tells search engines your site structure is broken.

Why it matters for your business: Broken links waste customer intent—someone reading your dispensary

guide clicks 'shop now' and bounces instead of converting; you also lose SEO ranking signals because search

engines see these as poor site quality.
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Technical root cause: Pages have been deleted, moved, or renamed (e.g., /shop-pickup/ was removed) without

redirects in place, and some product filter URLs have malformed query parameters or obfuscated email-

protection URLs that no longer resolve.

Recommended fix — step by step

1. Install the Broken Link Checker plugin (Plugins → Add New → search 'Broken Link Checker' → activate). Run

a full site scan to confirm all 120 links and export the report.

2. For pages that were intentionally removed (e.g., old shop URLs), create 301 redirects from the old URL to

the closest equivalent page: use Redirection plugin (Plugins → Add New → 'Redirection' → Redirects tab →

Add New → set Source URL to old link, Target to new page).

3. For /shop-pickup/ specifically, check if this page exists under a different URL in WordPress (Pages → All

Pages, search 'shop' or 'pickup'); if it exists, update all links to point to the correct current URL.

4. For product filter links (e.g., shop-pickup/?path=menu?refinementList…), verify your menu filtering plugin

(likely WooCommerce or custom code) generates valid filter URLs; test one filter link manually to see what

URL it should produce.

5. After redirects are in place, re-run Broken Link Checker to confirm all are resolved, then remove the plugin

to avoid performance overhead.

6. Set a calendar reminder to audit broken links monthly; add a note to your page-deletion checklist requiring

redirects before removal.

2. A11y: ARIA dialog and alertdialog nodes should have an accessible name

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: compliance

Page URL: https://greenleafwellness.com/

Rule: tier9.a11y.aria-dialog-name

What it means (plain English)

Your age-gate dialog (the popup that appears when visitors first arrive) is missing a label that screen readers

can announce. Screen reader users — including visually impaired customers — cannot understand what the

dialog is for because it has no accessible name. This is a WCAG 2.1 level A violation, meaning it fails baseline

accessibility compliance.

Why it matters for your business: Visually impaired customers cannot use your age gate, blocking legal

access to your site. This creates legal liability under the ADA and AAPA, and excludes a protected class of

users.

Technical root cause: The dialog element with id 'baag3-gate' (likely from an age-gate plugin like BAAG or

similar) has role='dialog' and aria-modal='true', but lacks an aria-label, aria-labelledby, or title attribute. Screen

readers need one of these to announce the dialog's purpose.

Recommended fix — step by step

1. Log into WordPress admin → Plugins, and identify the age-gate plugin (search for 'baag' or 'age gate' in

active plugins).

2. Open the plugin settings page. Look for options like 'Accessibility', 'Labels', or 'ARIA attributes'.

3. If the plugin has a field for 'Dialog Label' or 'Dialog Title', enter: 'Age Verification - Must be 21 or older to

enter this site'.

4. If no such field exists, check the plugin's GitHub issues or support docs for an 'accessibility' or 'a11y'

update; many age-gate plugins released updates in 2023–2024 to add aria-label support.
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5. If the plugin is unmaintained, consider switching to a modern alternative (e.g., WP Age Gate Pro, or a custom

short-code solution) that includes built-in ARIA labels.

6. After saving, use the free axe DevTools browser extension (axe DevTools for Chrome/Firefox) to re-scan the

page and confirm the dialog now has an accessible name.

3. A11y: Elements must meet minimum color contrast ratio thresholds

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://greenleafwellness.com/

Rule: tier9.a11y.color-contrast

What it means (plain English)

A notice banner at the top of your site uses white text (#ffffff) on a cyan background (#3ccbda), which creates

a contrast ratio of only 1.95:1. WCAG 2 AA standard requires at least 4.5:1 for normal text to be readable by

people with low vision or color blindness. This banner is hard to read for roughly 1 in 12 men and many people

over 65.

Why it matters for your business: Visitors with visual impairments or color vision deficiency may miss critical

messaging about account signup, reducing conversions and creating potential legal liability under accessibility

laws (ADA, AODA in Canada).

Technical root cause: The background color (#3ccbda, a bright cyan) is too light relative to white foreground

text. White text works well on dark backgrounds but fails on bright, saturated ones because there is insufficient

luminance difference.

Recommended fix — step by step

1. Log into WordPress admin → Appearance → Customize (or Edit Site if using block editor)

2. Locate the Site Notice / banner section styles

3. Change the text color from #ffffff (white) to #000000 (black) or #003d42 (dark teal) — test both for visual

preference

4. OR change the background color from #3ccbda to #005a66 (darker cyan) to maintain brand while improving

contrast

5. Use the WCAG Color Contrast Checker (https://webaim.org/resources/contrastchecker/) to verify the new

ratio is at least 4.5:1

6. Publish and re-run an accessibility audit to confirm the fix

4. A11y: Frames must have an accessible name

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: compliance

Page URL: https://greenleafwellness.com/

Rule: tier9.a11y.frame-title

What it means (plain English)

Your site has an iframe (a window embedded in your page) that lacks a descriptive name. Screen readers used

by blind and low-vision visitors cannot identify what this iframe contains or why it's there. This is a WCAG 2.1
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Level A violation — a legal compliance issue in most US states, and increasingly in Canada.

Why it matters for your business: Inaccessible embeds expose you to ADA litigation risk, reduce organic

search visibility (Google penalizes accessibility failures), and exclude customers with disabilities from your site.

Technical root cause: The iframe points to 'about:blank' (an empty placeholder) and has no title, aria-label, or

aria-labelledby attribute to tell assistive technology what it represents. The lazy-loading data attribute suggests

this may be a video embed or widget that failed to load its actual src.

Recommended fix — step by step

1. Log into WordPress admin → inspect the page in the editor; identify which plugin or shortcode is generating

this iframe (likely a video embed, map, or chat widget).

2. If it's a video embed: add title="[description]" (e.g., title="Cannabis product overview video") directly to the

iframe tag, or use a plugin like 'WP Accessibility' to auto-add titles.

3. If the iframe is from a third-party plugin (Calendly, Typeform, etc.), check that plugin's settings for an

accessibility label option and enable it.

4. If src="about:blank" is temporary/broken, either replace it with a real URL or hide the iframe from screen

readers using role="presentation" (only if it's purely decorative).

5. Run a fresh audit using WAVE (chrome extension) or axe DevTools to confirm the iframe now has an

accessible name.

6. If you use Rocket Lazy Load, check its settings (Settings → WP Rocket → Media → Lazy Loading) and

confirm it's not stripping title attributes; consider disabling lazy-load for iframes if needed.

P2 — 355 findings

1. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/

Rule: tier2.meta.no-description

What it means (plain English)

This page doesn't have a meta description — the 150-160 character summary that appears below your page

title in Google search results. Without it, Google generates a random excerpt from your page content, which

often looks unprofessional and doesn't tell potential customers what to expect.

Why it matters for your business: Missing meta descriptions reduce click-through rates from Google search

results; customers see an awkward snippet instead of your carefully-crafted message about first-time

dispensary visits, costing you qualified traffic.

Technical root cause: The WordPress page or post object is missing the meta description field in its SEO

metadata, likely because no SEO plugin was configured for this post or the field was left blank.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'First Time Visiting a Dispensary in Nevada'

2. Scroll to the Yoast SEO or Rank Math panel at the bottom of the editor (or install one if missing: Plugins →

Add New → search 'Yoast SEO' → Install & Activate)
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3. In the SEO plugin's meta description field, write a 155-160 character summary: e.g. 'First time at a Nevada

dispensary? Learn what to bring, what to expect, and how to navigate your first purchase safely and legally.'

4. Click 'Save' or 'Update' on the post

5. Repeat for other high-traffic pages (product pages, FAQ, age-verification landing page) using the same

plugin

2. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/wyld-gummies/

Rule: tier2.meta.no-description

What it means (plain English)

Your product page for Wyld Gummies is missing a meta description—a 150–160 character summary that

appears below your page title in Google search results. Without it, Google may auto-generate a snippet from

your page content, which often looks truncated or irrelevant to searchers.

Why it matters for your business: Missing meta descriptions lower click-through rates from search results

because potential customers see a poor preview of your product, reducing traffic to a high-intent product page.

Technical root cause: WordPress does not automatically generate meta descriptions; they must be explicitly

written in the page settings or via an SEO plugin like Yoast SEO, Rank Math, or All in One SEO.

Recommended fix — step by step

1. Install or activate an SEO plugin if not already active: Yoast SEO, Rank Math, or All in One SEO (WordPress

Plugins → Search → install).

2. Navigate to WordPress Admin → Pages → Wyld Gummies product page.

3. Scroll to the SEO plugin metabox (usually below the editor) and locate the Meta Description field.

4. Write a 150–160 character description emphasizing product name, key benefit, and brand (e.g., 'Wyld

Gummies—premium cannabis edibles with consistent dosing. Shop Greenleaf Wellness for quality, tested

products.').

5. Click Publish or Update.

6. Repeat for all other product pages missing descriptions (check via Yoast SEO → Internal Linking tool or

plugin Site Audit feature).

3. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/wyld-gummies/

Rule: tier2.schema.none

What it means (plain English)

Your product pages (like the Wyld Gummies page) don't include JSON-LD structured data—machine-readable

code that tells Google and other search engines exactly what your page is about. Without it, search engines
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have to guess whether a page is a product, a blog post, or something else, which makes it harder for them to

rank you correctly and display rich results (like star ratings or price info) in search.

Why it matters for your business: Missing schema data reduces your visibility in search results and prevents

Google from showing product details (price, availability, reviews) that drive clicks and conversions, especially

important for cannabis retailers competing on local search.

Technical root cause: WordPress theme or plugins are not automatically injecting schema.org markup for

products, or the markup was never added to the page template. Cannabis product pages need LocalBusiness +

Product schema to signal compliance and legitimacy.

Recommended fix — step by step

1. Install Yoast SEO Premium (if not already active) or Rank Math Free; both have built-in schema generators

for WooCommerce or custom post types.

2. If you use WooCommerce: ensure the plugin is set to emit Product schema. Go to WordPress admin → Yoast

SEO (or Rank Math) → Integrations → enable WooCommerce snippet output.

3. For the Wyld Gummies page specifically: in the post editor, scroll to the Yoast/Rank Math metabox, click

'Schema' tab, select 'Product' from the dropdown, and fill in: product name, price, currency (USD),

availability (in stock/out of stock), and a brief description.

4. Add LocalBusiness schema to your homepage or footer to signal your physical location and hours: go to

WordPress admin → appearance → customizer → add custom code section and paste LocalBusiness JSON-

LD with your address, phone, and hours.

5. Test the page at https://validator.schema.org/ by pasting the Wyld Gummies URL; confirm both Product and

LocalBusiness schemas appear with no errors.

6. Re-submit the page to Google Search Console (admin → coverage → request indexing) so Google re-crawls

with the new schema data.

4. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/bubba-fett-strain/

Rule: tier2.meta.no-description

What it means (plain English)

This product page (Bubba Fett strain) is missing a meta description — the 160-character snippet that appears

below your page title in Google search results. Without it, Google generates a random excerpt from your page

content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a generic snippet instead of a compelling reason to visit your Bubba Fett product page,

directly costing you traffic and sales.

Technical root cause: The WordPress post or page template is not populating the meta description field, either

because it's blank in the editor or the theme/plugin isn't outputting it to the HTML head tag.

Recommended fix — step by step

1. Log into WordPress admin → go to Posts or Products (depending on your setup) → find the Bubba Fett strain

page → scroll down to the Yoast SEO or Rank Math box (if installed)
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https://greenleafwellness.com/bubba-fett-strain/


2. If you use Yoast SEO: click the 'Readability' tab, locate the 'Snippet preview' area, and type a 155–160

character description that includes the strain name and a benefit (e.g., 'Bubba Fett cannabis strain: Relaxing

indica blend with earthy notes. Premium quality at Greenleaf Wellness.')

3. If you use Rank Math: click the 'General' tab in the Rank Math panel and paste your description into the

'Meta Description' field

4. If neither plugin is visible, install Yoast SEO (Plugins → Add New → search 'Yoast SEO' → Install → Activate),

then repeat step 1–2

5. Click 'Update' or 'Save' on the post, then wait 5–10 seconds and refresh the page to confirm the description

appears in the preview

6. Repeat this process for all other strain/product pages missing descriptions (check via Yoast SEO → Site

Audit or use a free tool like Screaming Frog to bulk-check)

5. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/bubba-fett-strain/

Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include JSON-LD schema markup—a machine-readable format that tells Google what

your content is about. This means search engines have to guess whether your page is about a product, a blog

post, or something else. For a cannabis retail site, schema helps Google understand your inventory, pricing, and

compliance details.

Why it matters for your business: Without schema markup, your product pages rank lower in search results,

especially in local/map searches, and you miss opportunities to show rich snippets (star ratings, pricing, in-

stock status) that drive clicks.

Technical root cause: WordPress doesn't add schema markup by default. Most sites rely on an SEO plugin (like

Yoast SEO or Rank Math) to inject it automatically, but either no plugin is active or it's not configured for

product pages.

Recommended fix — step by step

1. Install Yoast SEO (free version): Dashboard → Plugins → Add New → search 'Yoast SEO' → Install & Activate.

2. Open Dashboard → Yoast SEO → General → scroll to Schema tab → enable 'Schema output'.

3. Go to Dashboard → Yoast SEO → Integrations → connect your Google Search Console property (paste your

GSC verification code).

4. Edit a product page (e.g., Bubba Fett strain) → scroll to Yoast SEO meta box → click 'Schema' tab → verify

'Product' is selected; if not, change it.

5. Add key product details: fill in product title, price, availability (in stock/out of stock), and description; Yoast

will auto-generate schema.

6. Publish and wait 48 hours, then check Dashboard → Yoast SEO → Tools → Site Connections → Google

Search Console → fetch as Google to see if schema is indexed.

6. Missing meta description

Severity: P2 | Priority: 🟠  HIGH
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Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/rove-cartridges/

Rule: tier2.meta.no-description

What it means (plain English)

This product page is missing a meta description — the 160-character summary that appears under your page

title in Google search results. Without it, Google may auto-generate a snippet from your page content, which

often looks incomplete or irrelevant. This reduces click-through rate from search.

Why it matters for your business: Potential customers searching for 'Rove cartridges' or similar terms will see

a poorly formatted search result, leading fewer people to click through to this product page and ultimately

reducing online sales.

Technical root cause: The page was likely created without filling in the meta description field in WordPress, or

a plugin overwriting descriptions was disabled/misconfigured.

Recommended fix — step by step

1. Log in to WordPress → Pages → find 'Rove Cartridges' → scroll to Yoast SEO box (or All in One SEO if

installed)

2. In the 'Snippet Editor' section, click the meta description field and write a 150–160 character description

including 'Rove cartridges' (e.g., 'Shop premium Rove vape cartridges at Greenleaf Wellness. Lab-tested,

potent strains. Fast shipping & secure checkout.')

3. Click Update

4. Repeat for all other product pages missing descriptions (use Google Search Console or a WordPress SEO

plugin's audit tool to identify them)

5. If using Yoast, enable the 'Focus Keyword' feature to ensure descriptions match search intent

7. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/rove-cartridges/

Rule: tier2.schema.none

What it means (plain English)

Your product pages are missing structured data—machine-readable labels that tell Google what your products

are, their prices, and ratings. Without this, search engines have to guess, which means your products may not

appear in Google Shopping results or rich snippets (the special highlighted boxes in search results).

Why it matters for your business: Missing schema means lost visibility in Google search results and no

eligibility for product rich results, which typically see 15–30% higher click-through rates; for cannabis retailers

competing on local search, this directly reduces qualified traffic to product pages.

Technical root cause: WordPress is not automatically outputting JSON-LD structured data blocks. This

requires either a plugin (like Yoast SEO, Rank Math, or Schema.org) or manual theme modification to inject

schema into the page head.

Recommended fix — step by step
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1. Install Yoast SEO or Rank Math plugin (both have free tiers with schema support): Plugins → Add New →

search 'Yoast SEO' → Install & Activate

2. If using Yoast: Go to SEO → Search Appearance → Content Types → toggle 'Show Product posts in search

results' ON

3. If using Yoast: Edit the affected product page (rove-cartridges) → Yoast SEO panel → scroll to Schema →

verify 'Product' type is selected and price/availability fields are filled

4. Test output: Open https://greenleafwellness.com/rove-cartridges/ in your browser, right-click → View Page

Source, search for '"@context": "https://schema.org"' to confirm JSON-LD is present

5. Run page through Google's Rich Results Test (search.google.com/test/rich-results) and paste the URL to

verify schema is valid and recognized

8. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/slurricane-strain/

Rule: tier2.schema.none

What it means (plain English)

Your product pages (like the Slurricane Strain page) are missing structured data — machine-readable labels that

tell Google what kind of content you're showing. Without it, search engines have to guess whether you're selling

a product, describing a service, or sharing educational content. This makes it harder for Google to understand

and rank your pages.

Why it matters for your business: Missing schema data reduces your chances of appearing in Google's rich

results (star ratings, pricing, availability snippets), which directly lowers click-through rates from search and

makes you less competitive against other dispensaries.

Technical root cause: The page HTML contains no JSON-LD blocks (the standard format for schema.org

markup). WordPress doesn't automatically generate this for custom post types like cannabis strains without a

plugin or manual code addition.

Recommended fix — step by step

1. Install the Yoast SEO plugin (free version has schema support): Plugins → Add New → search 'Yoast SEO' →

Install & Activate

2. Configure Yoast for your strain post type: Yoast SEO → Settings → Search Appearance → toggle 'Show posts

of type: Strain' ON

3. Edit the Slurricane Strain post: set Title, Meta Description, and Readability in the Yoast box at bottom

4. In Yoast Schema tab on that post, select 'Product' as the schema type and fill in Price, Currency, and In

Stock status

5. Publish and wait 48 hours, then check Google Search Console (Search Appearance → Rich Results) to

confirm schema is being read

6. Repeat schema setup for all other strain product pages (batch with Bulk Edit if >10 pages)

9. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

https://greenleafwellness.com/rove-cartridges/
https://schema.org"'/
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Business category: seo

Page URL: https://greenleafwellness.com/stiiizy-carts-and-flower/

Rule: tier2.meta.no-description

What it means (plain English)

Your product page for Stiiizy carts doesn't have a meta description—that's the 160-character preview snippet

that appears under your link in Google search results. Without it, Google generates a random excerpt from your

page content, which often looks unprofessional and misses keyword opportunities. This missing description

applies to this specific product URL.

Why it matters for your business: Customers searching for Stiiizy products see a truncated, auto-generated

snippet instead of your crafted message, reducing click-through rate from search results and losing an

opportunity to highlight product benefits or promotions.

Technical root cause: The WordPress post or page editor for this product hasn't had a meta description

manually entered, and your SEO plugin (if installed) isn't auto-generating one.

Recommended fix — step by step

1. Log in to WordPress → go to Posts or Products → search for 'Stiiizy carts and flower' and click to edit

2. Scroll to the bottom and locate the Yoast SEO, Rank Math, or All in One SEO box (whichever plugin is active);

if none appear, install 'Yoast SEO' from Plugins → Add New

3. In the SEO plugin box, find the 'Meta description' field and enter a 150–160 character description, e.g.:

'Premium Stiiizy carts and flower at Greenleaf Wellness. Fast delivery, lab-tested quality. Shop now.'

4. Click 'Update' or 'Save' to publish the change

5. Repeat for other product pages that lack meta descriptions (check your SEO plugin's audit tools for a full

list)

10. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/stiiizy-carts-and-flower/

Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include JSON-LD structured data—machine-readable code that tells Google what

your products are, their prices, and availability. Without it, search engines have to guess what's on your page,

and they often guess wrong. This is especially important for cannabis retailers because Google needs to

understand you're a legitimate, licensed dispensary, not an illegal seller.

Why it matters for your business: Missing schema data reduces your chances of appearing in Google

Shopping results, local search, and rich snippets (like star ratings or price displays), which directly cuts into

qualified search traffic and online visibility for your products.

Technical root cause: WordPress doesn't auto-generate JSON-LD schema for custom product pages unless a

plugin like Yoast SEO, RankMath, or WooCommerce is configured to do so. Your site either lacks such a plugin

or it's not activated on product pages.

Recommended fix — step by step

https://greenleafwellness.com/stiiizy-carts-and-flower/
https://greenleafwellness.com/stiiizy-carts-and-flower/


1. Install and activate Yoast SEO (free version) via WordPress Admin → Plugins → Add New → search 'Yoast

SEO' → Install Now → Activate.

2. Go to Yoast SEO → General → Organization → fill in your business name, logo URL, and choose 'Local

Business' or 'Organization' as your type.

3. Navigate to each product page (e.g., /stiiizy-carts-and-flower/) → scroll to the Yoast SEO metabox → ensure

'Show in search results' is enabled.

4. In Yoast SEO → Integrations, enable WooCommerce integration if you use WooCommerce; if using custom

post types, go to Yoast SEO → Advanced → Post types and check that your product post type has 'Show in

search results' enabled.

5. Test one product page at Google's Rich Results Test (https://search.google.com/test/rich-results) to confirm

schema is now present.

6. Once confirmed, clear any caching plugins (WP Super Cache, W3 Total Cache, etc.) by visiting their settings

and clicking 'Purge Cache' or 'Empty Cache'.

11. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/marys-medicinals/

Rule: tier2.schema.none

What it means (plain English)

Your product pages are missing JSON-LD structured data — a machine-readable format that tells Google what

your page is about (e.g., product name, price, availability). Without it, search engines have to guess, which

means your products won't appear in rich search results (the fancy boxes with images and ratings that drive

clicks).

Why it matters for your business: Missing schema reduces your visibility in Google Search results for product

queries, directly harming organic traffic and online discovery for your cannabis products.

Technical root cause: WordPress theme or plugins are not automatically generating or injecting JSON-LD

blocks. The page HTML contains no <script type="application/ld+json"> tags.

Recommended fix — step by step

1. Install Yoast SEO (free version) via WordPress Admin → Plugins → Add New, search 'Yoast', click Install &

Activate

2. Go to Yoast SEO → Settings → XML Sitemaps → toggle 'Schema output' to ON

3. Edit the product page (Mary's Medicinals) in WordPress editor

4. Scroll to the Yoast SEO meta box at the bottom and ensure product details (price, availability, image) are

filled in the 'Schema' tab

5. Use Google's Rich Results Test (https://search.google.com/test/rich-results) to paste your product URL and

verify JSON-LD now appears

6. Repeat for all product pages in your catalog

12. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

https://search.google.com/test/rich-results)
https://greenleafwellness.com/marys-medicinals/
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Business category: seo

Page URL: https://greenleafwellness.com/binske-cannabis-products/

Rule: tier2.meta.no-description

What it means (plain English)

This product page is missing a meta description — the 160-character summary that appears under your page

title in Google search results. Without it, Google generates one automatically, which is often less compelling

and may not highlight your key selling points or cannabis product details.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a generic auto-generated snippet instead of your message about Binske products,

directly impacting traffic and revenue.

Technical root cause: The WordPress page or post for this product does not have a meta description field

filled in, either because the SEO plugin (Yoast, Rank Math, etc.) was not configured or the field was left blank

during product entry.

Recommended fix — step by step

1. Log into WordPress admin → Posts or Products (depending on your setup) → find the 'Binske Cannabis

Products' page

2. Scroll to the SEO plugin section (usually Yoast SEO, Rank Math, or All in One SEO); look for 'Meta

Description' field

3. Write a 155–160 character description highlighting Binske products, e.g., 'Premium Binske cannabis flower,

edibles & concentrates. Lab-tested. Fast shipping. Shop trusted strains at Greenleaf Wellness.'

4. Click 'Save' or 'Update' to publish the change

5. Repeat this process for all other product pages on the site using the same SEO plugin

13. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/binske-cannabis-products/

Rule: tier2.schema.none

What it means (plain English)

Your product pages lack structured data — machine-readable labels that tell Google what your content is about.

Without it, search engines can't confidently show your products in rich results (like product cards with price and

availability), even if your page content is great.

Why it matters for your business: Missing schema reduces visibility in Google Shopping, product snippets,

and local search results, likely costing you qualified traffic and conversions from price-conscious customers

searching for specific products.

Technical root cause: WordPress by default does not emit JSON-LD schema.org markup for products or local

business entities. The theme or a structured-data plugin is needed to generate these blocks.

Recommended fix — step by step

1. Install Yoast SEO Premium (if not already active) — it auto-generates schema for products, local business,

and more.

https://greenleafwellness.com/binske-cannabis-products/
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2. If using a different SEO plugin (Rank Math, All in One SEO), verify 'Product Schema' and 'Local Business' are

enabled in Settings → Schema.

3. If using WooCommerce for products: ensure 'Product Data' tab includes price, availability, and category,

then re-save products to trigger schema regeneration.

4. Open a product page (e.g., /binske-cannabis-products/) in Google's Rich Results Test

(search.google.com/test/rich-results) and verify the Product schema appears in the left panel.

5. If schema still absent, switch theme or add the Schema plugin 'All in One Schema Rich Snippets' and

configure it to auto-output Product + LocalBusiness markup.

6. Add schema for LocalBusiness in WordPress Customizer or plugin settings to claim your dispensary name,

address, phone, hours, and license info.

7. Re-submit your sitemap to Google Search Console to trigger re-crawl and schema indexing.

14. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/cannabiotix-cbx-products/

Rule: tier2.meta.no-description

What it means (plain English)

This product page is missing a meta description — the 160-character text snippet that appears below your page

title in Google search results. Without it, Google generates a generic excerpt from your page content, which

often looks unprofessional and misses your chance to highlight why customers should click your link instead of

a competitor's.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a vague snippet instead of your best sales pitch, costing you traffic and revenue.

Technical root cause: The WordPress page or post for this product doesn't have the meta description field

populated in the SEO plugin (Yoast, Rankmath, or All in One SEO) or the page template doesn't output a fallback

description.

Recommended fix — step by step

1. Log into WordPress admin → go to the product page 'Cannabiotix CBX Products'

2. Scroll to the SEO plugin panel (Yoast, Rankmath, or All in One SEO, depending on which is installed) and

locate the 'Meta Description' field

3. Write a 155–160 character description that includes the product name and a key benefit, e.g. 'Cannabiotix

CBX products deliver premium quality cannabis with lab-tested potency. Browse our full selection at

Greenleaf Wellness.'

4. Click 'Update' or 'Publish' to save the change

5. Repeat for all product pages flagged by the audit tool

6. Use Google Search Console (search.google.com) → Pages → filter by 'Missing meta description' to find any

others

15. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

https://greenleafwellness.com/cannabiotix-cbx-products/


Business category: seo

Page URL: https://greenleafwellness.com/cannabiotix-cbx-products/

Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include JSON-LD structured data — machine-readable code that tells Google what

your page is about (e.g., product name, price, availability). Without it, search engines have to guess your

content, and you miss rich features like product ratings or price snippets in search results.

Why it matters for your business: Missing schema reduces your visibility in Google Shopping and local search

results, which are critical for cannabis retail where customers actively search for specific strains and products.

Technical root cause: WordPress theme or page builder is not generating or inserting JSON-LD blocks. The

page HTML lacks <script type="application/ld+json"> tags for Product, LocalBusiness, or Organization schema.

Recommended fix — step by step

1. Install Yoast SEO (free version) or Rank Math via Plugins → Add New → search 'Yoast SEO' → Install and

Activate.

2. Go to the product page (Cannabiotix CBX Products) and edit it in WordPress.

3. In the Yoast SEO sidebar (bottom right of editor), scroll to Schema section and ensure 'Product' schema is

selected; fill in product name, price, and in-stock status.

4. If using Rank Math instead: go to Rank Math settings → Schema → enable Product schema template for

product pages, then re-edit the page to populate fields.

5. Test the page using Google's Rich Results Test (search.google.com/test/rich-results) — paste the URL and

verify JSON-LD blocks appear.

6. Repeat for all product listing pages in the /cannabiotix-cbx-products/ category.

16. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/resin8-cannabis-products/

Rule: tier2.meta.no-description

What it means (plain English)

The page about your Resin8 cannabis products is missing a meta description — the 155-character summary

that appears under your page title in Google search results. Without it, Google will auto-generate a snippet from

your page content, which may not highlight your best selling points or compliance info.

Why it matters for your business: Potential click-through rate loss in search results; customers may not see

why they should visit your product page over competitors' listings.

Technical root cause: The WordPress page editor did not have a meta description filled in the SEO plugin field

(or no SEO plugin is active to manage descriptions).

Recommended fix — step by step

1. Install Yoast SEO (free version) via WordPress Admin > Plugins > Add New; search 'Yoast SEO', click Install

Now, then Activate.

2. Go to Posts/Pages and open the 'Resin8 Cannabis Products' page in edit mode.

https://greenleafwellness.com/cannabiotix-cbx-products/
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3. Scroll to the Yoast SEO panel at the bottom; click the 'Snippet Editor' button.

4. In the 'Meta description' field, write 155 characters or fewer. Example: 'Premium Resin8 cannabis products—

lab-tested, compliant, and in stock. Browse flower, concentrates & edibles. [License #] | Greenleaf

Wellness.'

5. Click 'Save Draft' or 'Update' to apply the change.

6. Repeat for all product pages and high-traffic pages on your site.

17. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/resin8-cannabis-products/

Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include JSON-LD structured data — machine-readable code that tells Google what

your pages are about. Without it, search engines have to guess whether a page is a product listing, a blog post,

or something else. This makes it harder for Google to display rich results (like star ratings, prices, or availability)

in search results.

Why it matters for your business: Missing schema means you're losing click-through rate from search results

and passing ranking authority to competitors who have implemented it — especially critical for product pages

where users expect to see prices and inventory status.

Technical root cause: WordPress doesn't auto-generate JSON-LD by default. Either the site is using a

theme/plugin that doesn't output schema, or schema markup was never configured during setup.

Recommended fix — step by step

1. Install and activate Yoast SEO or Rank Math (both are WordPress plugins available in Plugins → Add New).

Rank Math is particularly strong for e-commerce/product schema.

2. In Yoast SEO: go to SEO → Search Appearance → Content Types, enable Product schema, then configure

Product fields (price, availability, rating) to map to your custom fields.

3. Alternatively in Rank Math: go to Rank Math → Schema → Product, add a new schema rule, and map your

product post type fields (product name, price, description, image) to the schema template.

4. Once enabled, revisit the affected product page (resin8-cannabis-products/) and check the page source

(Ctrl+U) to verify <script type="application/ld+json"> blocks appear.

5. Test the final markup in Google's Rich Results Test (https://search.google.com/test/rich-results) to confirm

it's valid before submitting to Google Search Console.

18. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/how-much-is-an-ounce-of-weed/

Rule: tier2.meta.no-description

What it means (plain English)

https://greenleafwellness.com/resin8-cannabis-products/
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This page doesn't have a meta description — the 155-character summary that appears under the page title in

Google search results. Without it, Google generates a random excerpt from the page content, which may look

unprofessional and doesn't include your key selling points or call-to-action.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results,

meaning fewer potential customers visit this pricing-comparison page even when it ranks well.

Technical root cause: The WordPress page or post is missing the meta description field in its SEO settings, or

the field was left blank during publication.

Recommended fix — step by step

1. Log into WordPress admin → Posts → search for 'how much is an ounce of weed' → click Edit

2. Scroll to the Yoast SEO / Rank Math meta box (below the editor or in a sidebar panel, depending on your

plugin)

3. Fill the 'Meta description' field with: 'Ounce prices at Greenleaf Wellness. Compare cannabis strains, quality,

and bulk pricing for your needs. Shop now.'

4. Ensure the description is 150–160 characters (Yoast will show a green light when correct)

5. Click 'Update' to save

6. Repeat for other high-traffic product/pricing pages (e.g., any page with 50+ monthly searches in Google

Search Console)

19. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/head-cheese-strain/

Rule: tier2.meta.no-description

What it means (plain English)

This product page (Head Cheese Strain) is missing a meta description — the 150-160 character summary that

appears below the page title in Google search results. Without it, Google auto-generates a snippet from your

page content, which is often choppy or irrelevant and wastes valuable real estate to convince shoppers to click.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results,

directly cutting foot traffic to your product pages and losing sales to competitors who have optimized their

listings.

Technical root cause: WordPress product pages (likely WooCommerce or custom post type) are not populating

the meta description field. This is commonly caused by: (1) the theme or plugin not exposing the meta

description field in the editor, or (2) the field existing but being left blank during content creation.

Recommended fix — step by step

1. Install Yoast SEO (free version) if not already active: Plugins → Add New → search 'Yoast SEO' → Install &

Activate

2. Navigate to the product page editor: Posts/Products → Head Cheese Strain → edit

3. Scroll to the Yoast SEO meta box at the bottom of the editor

4. In the 'SEO title & meta description' section, click 'Edit snippet' and write a 155-character description: e.g.,

'Head Cheese Strain: Premium hybrid cannabis with fruity, cheesy aroma. In stock now at Greenleaf

Wellness. Fast shipping, lab-tested quality.'

5. Verify the preview shows your description (not auto-generated text) in the search result preview

https://greenleafwellness.com/head-cheese-strain/


6. Click 'Update' to save

7. Repeat this process for all other product pages flagged in your audit report

20. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/head-cheese-strain/

Rule: tier2.schema.none

What it means (plain English)

Your product pages (like the Head Cheese strain page) are missing structured data — machine-readable code

that tells Google what type of content you're showing. Without it, search engines have to guess whether you're

selling a product, describing an article, or something else. This makes it harder for Google to display your

listings prominently in search results.

Why it matters for your business: Missing schema data reduces your chances of appearing in Google

Shopping results, local pack listings, and rich snippets — all of which drive qualified traffic to cannabis retailers.

Technical root cause: WordPress sites need explicit JSON-LD blocks added to pages, either via a plugin (like

Yoast SEO Premium, RankMath, or Schema Pro) or custom code in theme templates. The site currently has

none.

Recommended fix — step by step

1. Install and activate RankMath SEO (free tier) or Yoast SEO — both have schema wizards: Plugins → Add New

→ search 'RankMath' → Install & Activate.

2. For product pages (strain listings): in RankMath Settings → Schema, enable 'Product' schema type and map

fields (product name, price, availability, image).

3. For your dispensary homepage: add 'LocalBusiness' schema in RankMath → select 'Cannabis Store' or

'Retail Store' as business type, fill in phone, address, hours, license number.

4. Test each page type using Google's Rich Results Test (search.google.com/test/rich-results) — paste the

strain page URL and confirm 'Product' markup appears.

5. Submit updated sitemap to Google Search Console: Settings → Sitemaps → enter your sitemap URL.

21. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/

Rule: tier2.schema.none

What it means (plain English)

Your product pages are missing structured data—machine-readable code that tells Google what your content is

about. Without it, search engines have to guess whether a page is about a product, a blog post, or something

else entirely. This is especially important for cannabis retail, where clear product information helps search

engines understand your inventory and compliance details.

https://greenleafwellness.com/head-cheese-strain/
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Why it matters for your business: Missing schema reduces your chances of appearing in Google's rich results

(like product snippets with pricing and availability), which drives clicks and trust, particularly for price-

comparison searches where cannabis products compete heavily.

Technical root cause: WordPress installations rarely add JSON-LD schema automatically; most require a plugin

or manual template edits to inject the structured data into page headers.

Recommended fix — step by step

1. Install and activate the Yoast SEO plugin (Free version includes schema support) from WordPress Admin →

Plugins → Add New, search 'Yoast SEO', click Install Now.

2. Go to Yoast SEO → Tools → Schema editor, confirm it has auto-detected your site type; if not, set it to 'Local

Business' or 'Online Shop' depending on your business model.

3. Edit the affected product page (packwoods-how-much-are-they…) and go to the Yoast SEO block on the

right. Scroll to 'Schema' and ensure Product schema is enabled; fill in Product Name, Description, Price, and

In Stock status if fields appear.

4. For all product pages, install the WooCommerce plugin (if you're not already using it) or confirm your current

product plugin outputs schema—many do not by default.

5. If using a custom product post type, go to Settings → Permalinks → Post name structure, save, then visit a

product page and check the page source (Ctrl+F 'json+ld') to confirm schema appears.

6. Submit your site to Google Search Console (if not already done): go to search.google.com/search-console,

add property, paste your site URL, and Google will crawl and validate your schema within 48 hours.

22. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/kosmik-edibles/

Rule: tier2.meta.no-description

What it means (plain English)

This product page (Kosmik Edibles) doesn't have a meta description — the 155-character summary that

appears under your page title in Google search results. Without it, Google generates a random snippet from

your page content, which often looks unprofessional and doesn't convince people to click.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results,

directly impacting traffic to your product pages and lost revenue from customers who choose competitors

instead.

Technical root cause: The WordPress page or post was created without filling in the meta description field

(typically in Yoast SEO, Rank Math, or native WordPress block editor). This field is not auto-populated by

default.

Recommended fix — step by step

1. Log in to WordPress admin → click 'Edit' on the Kosmik Edibles page

2. If using Yoast SEO plugin: scroll to the Yoast metabox below the editor → find 'Snippet preview' → click the

pencil icon next to the description → write 55–160 characters describing the product (e.g., 'Premium Kosmik

Edibles: lab-tested cannabis-infused gummies. Fast delivery across [state]. Shop now.')

3. If using Rank Math plugin: open the Rank Math panel on the right → click 'Focus Keyword' tab → find 'Meta

Description' field → enter 55–160 characters

https://greenleafwellness.com/kosmik-edibles/


4. If using no SEO plugin: install Yoast SEO (free version) from Plugins → Add New, activate it, then repeat step

2

5. Click 'Update' or 'Publish' to save

6. Repeat for all other product pages with missing descriptions (scan WordPress admin → Posts/Products to

find them quickly)

23. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/kosmik-edibles/

Rule: tier2.schema.none

What it means (plain English)

Your product pages are missing JSON-LD structured data—machine-readable code that tells search engines

what your products are, their prices, and ratings. Without it, Google has to guess what it's looking at, which

means your edibles and other products may not appear in rich search results (those fancy cards with stars,

prices, and availability).

Why it matters for your business: Missing schema means you're invisible in Google Shopping results and

product carousels, costing you qualified traffic from customers actively searching for cannabis products at the

point of purchase.

Technical root cause: WordPress is not automatically generating or inserting Product, BreadcrumbList, or

LocalBusiness JSON-LD blocks on your product pages. The theme or a plugin needs to create and output this

structured data.

Recommended fix — step by step

1. Install and activate Yoast SEO Premium (if not already active). Go to WordPress Admin → Yoast SEO →

Settings → XML Sitemaps, confirm it is enabled.

2. Edit the product page at /kosmik-edibles/. In the WordPress editor sidebar, find the Yoast SEO metabox →

scroll to 'Schema' tab.

3. Verify 'Product' schema type is selected. If not, click the schema type dropdown and select 'Product'.

4. Fill in: Product name (auto-populated), description, price, currency (USD), and availability (In Stock / Out of

Stock). Yoast will auto-generate the JSON-LD block.

5. If using WooCommerce, ensure the WooCommerce Yoast SEO extension is installed (Admin → Plugins →

search 'WooCommerce Yoast SEO'). This auto-maps product data to schema.

6. Publish the page and use Google's Rich Results Test (google.com/test/rich-results) to paste the product

URL and verify the schema is now present and valid.

7. Repeat steps 2–6 for all other cannabis product pages (e.g., /products/ listing, /edibles/, etc.).

24. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/mojave-flower/

https://greenleafwellness.com/kosmik-edibles/
https://greenleafwellness.com/mojave-flower/


Rule: tier2.meta.no-description

What it means (plain English)

Your product page for Mojave Flower is missing a meta description — the 155-character summary that appears

below the page title in Google search results. Without it, Google generates a random snippet from your page

content, which often looks unprofessional and may not highlight your key selling points or compliance

information.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a generic preview instead of a compelling reason to visit your product page, directly

impacting foot traffic and online orders.

Technical root cause: The WordPress page or post editor wasn't filled in with a custom meta description, and

no SEO plugin default was configured to auto-generate one.

Recommended fix — step by step

1. Log into WordPress admin → Pages/Posts → Edit the Mojave Flower page

2. Scroll to the Yoast SEO meta box (or equivalent plugin you use: Rank Math, SEMrush, etc.)

3. In the 'Meta description' field, write a 155-character description: e.g., 'Premium Mojave Flower strain. Lab-

tested, hand-selected cannabis buds. Free delivery on orders over $50. Licensed & compliant. [License #].'

4. Verify the green/amber light appears in the plugin readability check

5. Click Update/Publish and wait 24 hours for Google to crawl and re-index

6. Repeat for all other product pages missing meta descriptions (use your SEO audit crawl report to identify

them all at once)

25. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/camp-cannabis/

Rule: tier2.meta.no-description

What it means (plain English)

Your Camp Cannabis page is missing a meta description — the 160-character summary that appears below your

page title in Google search results. Without it, Google will auto-generate a snippet from your page text, which

often looks incomplete or unhelpful to potential customers.

Why it matters for your business: A missing or auto-generated description reduces click-through rates from

search results; customers see a poor preview and choose a competitor's listing instead.

Technical root cause: The page was likely created without filling in the meta description field in WordPress, or

the theme/plugin does not populate it by default.

Recommended fix — step by step

1. Log into WordPress admin → Pages → search for 'Camp Cannabis' and open it

2. Scroll to the bottom of the editor and locate the SEO plugin panel (Yoast SEO, Rank Math, or All in One SEO

— depending on what's installed)

3. In the meta description field, write a 155–160 character description that includes your primary keyword (e.g.,

'Premium cannabis products in [City]. Explore flower, edibles, and concentrates at Greenleaf Wellness.').

https://greenleafwellness.com/camp-cannabis/


4. Set the focus keyword to 'camp cannabis' or your target phrase

5. Save/publish the page and monitor in Google Search Console after 1–2 weeks to confirm the new description

appears in results

26. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/camp-cannabis/

Rule: tier2.schema.none

What it means (plain English)

Your product pages are missing structured data — machine-readable code that tells Google what your products

are, their prices, and ratings. Without it, search results show plain text instead of rich cards with reviews,

availability, and pricing.

Why it matters for your business: Missing schema reduces click-through rates from Google search results

and limits your ability to appear in Google Shopping or local cannabis product listings, directly hurting discovery

and online revenue.

Technical root cause: WordPress sites need schema markup either added via a plugin (like Yoast SEO or

Schema Pro) or custom code in theme templates. None is currently present on product pages.

Recommended fix — step by step

1. Install Yoast SEO plugin (free tier) from WordPress admin → Plugins → Add New → search 'Yoast SEO' →

Activate

2. Go to Yoast SEO settings → General → Features and ensure 'Schema' is enabled (should be by default)

3. Open Yoast SEO → XML Sitemaps and verify your product pages are included in the sitemap

4. For the affected product page (/camp-cannabis/), edit the post and scroll to Yoast SEO metabox → choose

'Product' from the Schema section dropdown

5. Add product details in the Yoast schema block: product name, price, description, and rating/review count if

available

6. Publish and wait 1–2 days, then test using Google's Rich Results Test (https://search.google.com/test/rich-

results) to confirm schema renders

7. Repeat steps 4–6 for all product and category pages

27. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/best-discreet-vape-pens/

Rule: tier2.meta.no-description

What it means (plain English)

Your product page about vape pens doesn't have a meta description — the 160-character summary that

appears below your page title in Google search results. Without it, Google generates a random snippet from

https://greenleafwellness.com/camp-cannabis/
https://search.google.com/test/rich-results)
https://search.google.com/test/rich-results)
https://greenleafwellness.com/best-discreet-vape-pens/


your page content, which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Missing descriptions reduce click-through rates from search results;

potential customers see a generic excerpt instead of your sales pitch, costing you traffic and revenue from an

already-ranking page.

Technical root cause: The WordPress page or post doesn't have a meta description field filled in the SEO

plugin (likely Yoast SEO, Rank Math, or All in One SEO) or the theme's native meta field.

Recommended fix — step by step

1. Log into WordPress Admin → Posts/Pages → find 'Best Discreet Vape Pens' post.

2. Scroll to the SEO plugin section (usually at bottom; look for 'Yoast SEO' or 'Rank Math' box).

3. Click 'Edit snippet' or similar button to reveal the meta description field.

4. Write a 150–160 character description highlighting the product benefit (e.g., 'Discreet vape pens for

cannabis — portable, rechargeable, compliant with [state]. Order online today.').

5. Verify the description preview shows completely in the mock search result.

6. Click 'Update' or 'Save' on the post.

7. Repeat this for all product pages missing descriptions (use your SEO plugin's audit report to find them).

28. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/best-discreet-vape-pens/

Rule: tier2.schema.none

What it means (plain English)

Your product pages are missing JSON-LD structured data — machine-readable code that tells Google what your

pages are about. Without it, search engines can't easily understand your product details, prices, or availability,

which means your listings appear less rich in search results compared to competitors who have this data.

Why it matters for your business: Missing schema markup reduces your visibility in Google Shopping results

and product-focused search queries, directly limiting qualified traffic to high-intent product pages like your

vape pen listings.

Technical root cause: WordPress sites require either manual schema markup in the page template, or a

structured data plugin (like Yoast SEO, Rank Math, or Schema Pro) to auto-generate JSON-LD blocks. Currently

neither is active on this page.

Recommended fix — step by step

1. Install and activate Yoast SEO Premium (or Rank Math Pro) if not already installed — go to WordPress

Dashboard → Plugins → Add New → search 'Yoast SEO' → Install Now → Activate

2. Go to WordPress Dashboard → Yoast SEO → General → Features and ensure 'Schema output' is toggled ON

3. Navigate to the affected product page (best-discreet-vape-pens) in WordPress editor

4. In the Yoast SEO sidebar, scroll to 'Schema' tab and select 'Product' from the content type dropdown

5. Fill in required fields: Product name, price, currency, availability status, and product image URL

6. Save and publish the page, then test using Google's Rich Results Test (https://search.google.com/test/rich-

results) to confirm JSON-LD appears

https://greenleafwellness.com/best-discreet-vape-pens/
https://search.google.com/test/rich-results)
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7. Apply the same schema type to all other product pages — use Yoast's bulk edit feature (Dashboard → Yoast

SEO → Tools → Bulk Editor) to set schema type 'Product' for all pages matching '/products/' or '/shop/' path

29. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/kuno-cannabis/

Rule: tier2.meta.no-description

What it means (plain English)

This product page is missing a meta description — the 150–160 character summary that appears under your

page title in Google search results. Without it, Google will auto-generate a snippet from your page content,

which may be incomplete or less compelling. This hurts click-through rate from search.

Why it matters for your business: Fewer clicks from Google search results means fewer visitors to your

product pages, directly reducing traffic and potential sales from organic search.

Technical root cause: The page was published without a meta description tag in the HTML head. WordPress

does not auto-populate this field; it must be set manually per page or via an SEO plugin.

Recommended fix — step by step

1. Install Yoast SEO plugin (free version) if not already active: WordPress admin → Plugins → Add New →

search 'Yoast SEO' → Install & Activate.

2. Go to WordPress admin → Pages, open the 'Kuno Cannabis' product page.

3. Scroll to the 'Yoast SEO' panel at the bottom of the editor; in the 'Snippet' section, fill the 'Meta description'

field with 150–160 characters describing this product (e.g., 'Kuno Cannabis strain: high-quality flower with

energizing effects. Lab-tested, compliant, available at Greenleaf Wellness.').

4. Ensure the description includes the product name and a key benefit or attribute relevant to customers.

5. Click 'Update' to save the page.

6. Repeat for all other product pages missing descriptions (use WordPress admin → Pages to audit the full list).

30. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/

Rule: tier2.meta.no-description

What it means (plain English)

This page about live resin, rosin, and badder doesn't have a meta description — the 150-160 character summary

that appears under the page title in Google search results. Without it, Google generates one automatically,

which is often choppy or less compelling than what you'd write.

Why it matters for your business: A weak auto-generated description reduces click-through rate from search

results; customers shopping for product information may skip your page for a competitor's if the snippet

doesn't clearly explain what they'll find.

https://greenleafwellness.com/kuno-cannabis/
https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/


Technical root cause: The page was published without the meta description field filled in WordPress's SEO

plugin (likely Yoast, Rank Math, or core block editor), so no description tag was rendered in the HTML head.

Recommended fix — step by step

1. Log in to WordPress and open the live-resin-vs-rosin-vs-badder post or page in the editor.

2. Scroll to the SEO section (usually at the bottom if using Yoast SEO, or in a sidebar if using Rank Math).

3. In the 'Meta description' field, write a 155-160 character summary: e.g., 'Learn the differences between live

resin, rosin, and badder. Discover potency, flavor, and effects to choose the right concentrate for you.'

4. Click 'Update' or 'Publish' to save the change.

5. Repeat this for other product-comparison and educational pages that lack descriptions.

31. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about live resin, rosin, and badder has no structured data markup—essentially machine-readable

labels that tell Google what the page is about. Search engines use this to understand content type, author,

publish date, and other details, which helps them rank and display your content better in search results.

Why it matters for your business: Without schema markup, Google may struggle to recognize this educational

content as authoritative cannabis information, limiting visibility in search results and reducing organic traffic to

a page that could drive dispensary visits or product awareness.

Technical root cause: WordPress sites require either manual JSON-LD code insertion in the page template, or

a plugin like Yoast SEO, RankMath, or All in One SEO to auto-generate schema.org markup. This site appears to

have neither active.

Recommended fix — step by step

1. Install and activate 'Yoast SEO' or 'RankMath' plugin from WordPress plugin directory (Plugins → Add New →

search 'Yoast SEO')

2. Activate the plugin and go to its Settings → XML Sitemaps & Data; toggle 'Organization schema' and 'Article

schema' ON

3. Return to the affected blog post (Posts → Edit) and verify the plugin now shows a 'Schema' section in the

sidebar; confirm 'Article' is selected as content type

4. Update the post's Publish date, Author, and Featured Image (if missing) to populate all schema fields

5. Save and visit the live URL; use Google's Rich Results Test (search.google.com/test/rich-results) to confirm

Article schema now appears

32. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/


Page URL: https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/

Rule: tier2.meta.no-description

What it means (plain English)

This page is missing a meta description — the 150–160 character summary that appears below the page title in

Google search results. Without it, Google may auto-generate a snippet from your page text, which often looks

unprofessional and misses your key selling points. This is a quick fix that directly affects click-through rate from

search.

Why it matters for your business: Users seeing your search result will have no clear reason to visit your guide

instead of a competitor's; missing descriptions typically reduce click-through rates by 5–15%, cutting organic

traffic and potential customers to your site.

Technical root cause: The WordPress page/post is published without a meta description field filled in. By

default, WordPress does not auto-generate descriptions; they must be manually entered or populated via an

SEO plugin.

Recommended fix — step by step

1. Log in to WordPress admin → Posts → find the article 'How to Use Cannabis Concentrates…'

2. Scroll to the SEO plugin section (Yoast SEO, Rank Math, or All in One SEO) — look for a 'Meta Description'

field below the editor

3. Write a 150–160 character description that includes your main keyword ('cannabis concentrates') and a

benefit (e.g., 'Learn safe, non-dabbing methods for enjoying cannabis concentrates. Expert tips &

techniques for all experience levels.')

4. Click 'Update' to save

5. Repeat this process for all other posts/pages flagged with the same issue (run a site audit via your SEO

plugin to find them all)

33. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/

Rule: tier2.schema.none

What it means (plain English)

Your product and educational pages are missing structured data—machine-readable code that tells Google

what your content is about. Without it, search engines have to guess whether a page is a product, article, or

something else. For a cannabis wellness site, this means Google can't confidently show your content in search

results or rich snippets (those fancy boxes with ratings, prices, or how-to steps).

Why it matters for your business: Missing schema reduces your chances of appearing in Google's featured

snippets and specialized search results, directly lowering organic traffic and customer discovery for educational

and product content.

Technical root cause: The page lacks JSON-LD markup in its HTML head or body. WordPress doesn't generate

schema automatically for most themes; you need a plugin or manual code to output it.

Recommended fix — step by step

https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/
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1. Install and activate the Yoast SEO plugin (free version) or Rank Math (free version). Both auto-generate

schema for posts, pages, and products.

2. In WordPress admin, go to Plugins → Add New → search 'Yoast SEO' → Install Now → Activate.

3. Navigate to Yoast SEO → Search Appearance → Content Types. Toggle 'Show in search results' to ON for

Posts and Pages.

4. Go to the specific article URL in WordPress editor → Yoast SEO metabox (right sidebar) → select 'Article' as

the content type and fill in Focus Keyword ('how to use cannabis concentrates').

5. For any product pages, install WooCommerce if not already active, then Yoast will auto-generate Product

schema with price, availability, and reviews.

6. After saving, use Google's Rich Results Test (search.google.com/test/rich-results) to paste your page URL

and verify schema is now present and valid.

34. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/

Rule: tier2.meta.no-description

What it means (plain English)

This page is missing a meta description — the 155-character summary that appears under your page title in

Google search results. Without it, Google will auto-generate a snippet from your page content, which often

looks incomplete or irrelevant. This is the page about ski resorts near Reno/Tahoe, which appears off-brand for

a cannabis wellness site.

Why it matters for your business: Missing descriptions reduce click-through rates from search results, and

this off-topic content dilutes your site's topical authority, making it harder for Google to rank your actual

cannabis/wellness pages.

Technical root cause: The page is either a legacy page, auto-generated, or created without SEO setup in

WordPress. The meta description field in the WordPress editor was not filled in, and no SEO plugin default was

configured.

Recommended fix — step by step

1. Log in to WordPress → Pages → Find 'ski-resorts-near-reno-nv-and-tahoe-ca' → Edit

2. Install Yoast SEO plugin (if not already active) via Plugins → Add New → search 'Yoast SEO' → Install &

Activate

3. Scroll to 'Yoast SEO' metabox below the editor → Meta description field

4. Write a 150–160 character description like: 'Discover winter recreation near Reno & Tahoe. Greenleaf

Wellness guides you to outdoor activities and relaxation options in the Sierra Nevada region.'

5. Consider whether this page aligns with your cannabis/wellness brand — if not, either 301 redirect it to a

relevant page or delete it to improve topical focus

6. After saving, resubmit the page URL via Google Search Console → Inspect → Request Indexing to refresh

Google's cached version

35. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/


Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/top-7-best-edibles-in-nevada/

Rule: tier2.meta.no-description

What it means (plain English)

The page about edibles in Nevada doesn't have a meta description — a 155-character summary that appears

under the page title in Google search results. Without it, Google generates a random snippet from your page

content, which often looks unprofessional and doesn't tell potential customers what they'll find.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

customers see a generic excerpt instead of a compelling reason to visit your edibles guide, losing traffic to

competitors with better search listings.

Technical root cause: The WordPress post or page is missing the meta description field in the Yoast SEO

plugin (or equivalent SEO tool), so no description is being sent to search engines.

Recommended fix — step by step

1. Log into WordPress admin → Posts → Find 'Top 7 Best Edibles in Nevada'

2. Scroll to the Yoast SEO box at the bottom of the editor (or in the sidebar, depending on your theme)

3. Click 'Edit snippet' and paste a meta description like: 'Discover the 7 best cannabis edibles available in

Nevada dispensaries. Compare effects, potency, and pricing.'

4. Ensure the description is 150–160 characters (Yoast will show a green light when correct)

5. Click 'Update' to save the post

6. Repeat for other blog posts and product pages without descriptions (audit your 10–15 highest-traffic pages

first)

36. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/top-7-best-edibles-in-nevada/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about edibles in Nevada has no structured data — machine-readable labels that tell Google what

the page is about. Think of it like the difference between a shelf with organized product cards versus a pile of

items. Google uses these labels to understand your content better and display rich results (stars, snippets,

FAQs) in search.

Why it matters for your business: Without schema markup, your cannabis content ranks as plain blue links

instead of featured snippets or knowledge panels, reducing click-through rates from local searches where users

are actively looking for products.

Technical root cause: The WordPress theme or content lacks JSON-LD schema.org blocks. Most modern

WordPress themes include basic schema, but cannabis-specific or older themes often skip it, or your theme

requires manual activation.

Recommended fix — step by step

https://greenleafwellness.com/top-7-best-edibles-in-nevada/
https://greenleafwellness.com/top-7-best-edibles-in-nevada/


1. Install the free Yoast SEO plugin (wordpress.org/plugins/wordpress-seo/), activate it, and go to Yoast SEO →

Integrations to enable schema markup for blog posts

2. In the post editor for the edibles article, scroll to the Yoast SEO block at the bottom, click 'Schema' tab, and

confirm Article schema is enabled

3. If using a different SEO plugin (e.g., Rank Math), open its dashboard → Tools → Schema Generator, select

'BlogPosting', fill in title/author/date, and insert into the post

4. For cannabis-specific schema, consider adding FAQPage schema (if the post has Q&A sections) or

LocalBusiness schema in your site-wide settings: Settings → Yoast SEO → Site Representation →

Organization, add your license number and address

5. Test the fix using Google's Rich Results Test (search.google.com/test/rich-results), paste the post URL, and

confirm Article or FAQ schema appears in the preview

6. Repeat schema activation for all high-traffic posts (top products, strain guides, dosing info)

37. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/

Rule: tier2.meta.no-description

What it means (plain English)

This page doesn't have a meta description — the 155-character summary that appears below the page title in

Google search results. Without it, Google will auto-generate a snippet from your page content, which is often

less compelling and may not highlight your key selling points.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a generic excerpt instead of your messaging about flower and pre-rolls, hurting traffic

to this high-value product page.

Technical root cause: The WordPress page or post does not have a meta description tag in the HTML <head>,

likely because the SEO plugin (Yoast, Rank Math, or All in One SEO) was not configured to add one, or the field

was left blank during page creation.

Recommended fix — step by step

1. Log into WordPress admin and open the affected post/page (Best Flower and Pre-Rolls in Nevada).

2. Scroll to the SEO plugin section at the bottom (Yoast, Rank Math, or All in One SEO — whichever is

installed).

3. Locate the 'Meta Description' field and enter a unique, benefit-focused description: e.g., 'Shop premium

flower and pre-rolls in Nevada. Hand-selected strains, lab-tested quality, and fast delivery to your door.'

4. Ensure the description is 150–160 characters (the plugin will show a character counter and preview).

5. Click Update/Publish.

6. Verify the change in browser DevTools (F12 → Elements tab → search for 'meta name=description') or via

Google Search Console's URL Inspection tool.

38. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/


Business category: seo

Page URL: https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post about cannabis concentrates doesn't have a meta description — the short text snippet (usually

150–160 characters) that appears below your page title in Google search results. Without it, Google generates

one automatically, which is often incomplete or less compelling than what you'd write. This reduces click-

through rates from search results.

Why it matters for your business: Lower click-through rates from organic search mean fewer visitors to your

content hub, which hurts traffic volume and reduces opportunities to build audience trust and drive dispensary

visits.

Technical root cause: The WordPress page or post is missing the meta description tag in its HTML head, likely

because the Yoast SEO or Rank Math plugin wasn't configured for this post, or the field was left blank during

publication.

Recommended fix — step by step

1. Log in to WordPress admin → Posts → find 'Top 7 Best Cannabis Concentrates in Nevada'

2. Scroll to the Yoast SEO (or Rank Math) box below the editor

3. Click the 'Edit snippet' button to view the preview

4. In the 'Meta description' field, write a compelling 150–160 character summary (e.g., 'Discover the top 7

cannabis concentrates in Nevada: potency, flavor, and quality compared. Expert guide for beginners &

connoisseurs.')

5. Ensure it includes the target keyword ('cannabis concentrates Nevada') naturally

6. Click 'Update' on the post to save

7. Repeat this process for other blog posts flagged in your SEO audit (check Yoast → Tools → Bulk Editor for a

list)

39. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post about vape carts in Nevada doesn't have a meta description — that's the 155-character summary

that appears under your page title in Google search results. Without it, Google generates a random excerpt from

your content, which is usually less compelling and may not include your key selling points.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a generic snippet instead of a persuasive summary, costing you traffic and sales even if

you rank well.

Technical root cause: The meta description tag (a snippet of HTML in the page <head>) was either never

written or was accidentally deleted during a content update.

Recommended fix — step by step

https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/
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1. Log into WordPress admin → go to Posts → edit 'Top 7 Best Vape Carts in Nevada'

2. Scroll to the Yoast SEO box at the bottom of the editor (if installed) or the WordPress native meta section; if

you don't see it, install the Yoast SEO plugin via Plugins → Add New

3. In the Yoast SEO box, paste this meta description into the 'Meta description' field: 'Discover the top 7 vape

carts in Nevada. Our expert guide reviews quality, potency, and flavor. Find your perfect cart today.'

4. Ensure the description is 150–160 characters long (Yoast will show a green check when it's right)

5. Click Update/Publish

6. Repeat for any other blog posts or product pages without meta descriptions (run a quick Yoast SEO audit or

export your pages via WordPress → Tools → Export to spot them)

40. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/best-dispensaries-in-nevada-2023/

Rule: tier2.meta.no-description

What it means (plain English)

This page doesn't have a meta description — the 160-character summary that appears under the page title in

Google search results. Without it, Google generates a random snippet from your page text, which often looks

unprofessional and doesn't encourage clicks. For a cannabis retail guide like this, a custom description is

crucial to stand out in search results.

Why it matters for your business: A missing meta description reduces click-through rate from organic search;

potential customers see a generic or confusing excerpt instead of your value proposition, leading to lost

dispensary traffic and sales.

Technical root cause: The WordPress page or post was published without filling in the meta description field in

your SEO plugin (likely Yoast SEO, Rank Math, or WordPress core), or the description was deleted.

Recommended fix — step by step

1. Log into WordPress admin → go to Posts or Pages → find 'best-dispensaries-in-nevada-2023' → open it for

editing

2. If using Yoast SEO: scroll to the 'Yoast SEO' meta box at the bottom → click the 'Snippet Editor' → paste a

150–160 character description like 'Explore Nevada's top-rated cannabis dispensaries. Compare quality,

selection, and pricing at Greenleaf Wellness.'

3. If using Rank Math: click the 'Rank Math' button on the right sidebar → under 'Meta' tab → fill 'Meta

Description' field with the same content

4. If using no plugin: add to the post's 'Custom Fields' (Screen Options → check 'Custom Fields') a field named

'description' with the same text, then confirm your theme outputs it in the <head>

5. Click 'Update' and verify the description appears in a Google search preview (use Google Search Console or

a SERP simulator tool within 24–48 hours)

41. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

https://greenleafwellness.com/best-dispensaries-in-nevada-2023/


Page URL: https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/

Rule: tier2.meta.no-description

What it means (plain English)

Your article page about THC drinks doesn't include a meta description — the 155-character summary that

appears below your page title in Google search results. Without it, Google auto-generates text from your page,

which is usually less compelling and may hurt click-through rates.

Why it matters for your business: Missing meta descriptions reduce organic search click-through rate by 5–

15%, meaning fewer customers discovering your content through Google and landing on your site.

Technical root cause: The page was likely published without filling in the meta description field in WordPress,

or the field was left blank during content creation.

Recommended fix — step by step

1. Log into WordPress admin → Posts → find 'The 11 Best THC Drinks in Nevada'

2. Scroll to the Yoast SEO box at the bottom of the editor (or use the SEO sidebar if visible)

3. Click 'Edit snippet' and write a 155-character description that includes your target keyword and a benefit

(e.g., 'Discover the top 11 THC-infused drinks in Nevada for 2024. Premium selection, lab-tested, available

at Greenleaf Wellness.')

4. Preview the snippet in the Yoast preview to confirm it displays fully

5. Click 'Publish' or 'Update'

6. Audit your other top blog posts and product pages for missing descriptions using Yoast's Content Audit or

by searching 'meta description' in WordPress SEO → Tools → Bulk Editor

42. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about THC drinks has no structured data—machine-readable code that tells Google what the

page is about. Search engines use this to understand content better and may display richer results (like star

ratings or excerpts) in search listings. Without it, you're making Google work harder to understand your content.

Why it matters for your business: Missing schema reduces your chances of appearing in Google's featured

snippets and product-rich results, which is especially valuable for cannabis content where search visibility is

already constrained by platform policies.

Technical root cause: WordPress is not automatically generating or inserting JSON-LD schema.org markup for

blog posts. This typically requires either a dedicated SEO plugin (like Yoast SEO, RankMath, or All in One SEO)

or manual code addition to your theme's template files.

Recommended fix — step by step

1. Install Yoast SEO (free version): WordPress Admin → Plugins → Add New → search 'Yoast SEO' → Install and

Activate.

2. After activation, go to Yoast SEO → General → Features and toggle ON the 'XML Sitemaps' and

'Breadcrumbs' options.

https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/
https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/


3. Edit the blog post at /the-11-best-thc-drinks-in-nevada/ and scroll to the Yoast SEO meta box at the bottom;

fill in 'Focus Keyphrase' (e.g., 'best THC drinks Nevada'), Readability grade, and Keyword density—Yoast will

auto-generate JSON-LD schema as you optimize.

4. Alternatively, if you prefer RankMath: uninstall Yoast, install RankMath free → RankMath → Wizard → connect

your Google Search Console → RankMath will auto-generate schema for posts and pages.

5. Verify schema is live: visit https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/ in Google's Rich

Results Test (https://search.google.com/test/rich-results) and confirm the structured data block appears.

43. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/nevada-weed-laws-for-tourists/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about Nevada weed laws has no structured data markup — machine-readable code that tells

Google what type of content it is (article, guide, FAQ, etc.). Without it, search engines have to guess the page's

purpose and may not display it optimally in search results or AI overviews.

Why it matters for your business: Missing schema reduces your chances of appearing in featured snippets,

Google's 'People Also Ask' section, and AI-powered search summaries — all high-traffic opportunities for

informational content that drives qualified visitors to your site.

Technical root cause: WordPress is not automatically generating or inserting JSON-LD schema blocks for blog

posts. Either your SEO plugin is not configured, or the theme does not include schema generation by default.

Recommended fix — step by step

1. Install Yoast SEO (if not already active): go to Plugins → Add New, search 'Yoast SEO', install and activate.

2. Activate schema features: log in to WordPress admin, go to Yoast SEO → Settings → XML Sitemaps, scroll to

'SEO data optimizer', ensure 'Schema output' is toggled ON.

3. Edit the affected post: go to Posts → search 'Nevada weed laws for tourists' → open it → scroll to Yoast SEO

meta box at bottom → under 'Schema', select 'Article' from the dropdown.

4. Add key fields: fill 'Article type', 'Date published', and 'Date modified' (Yoast will pre-fill most).

5. Repeat for other blog posts: audit your top 10-15 evergreen posts and apply schema to each.

6. Test: use Google's Rich Results Test (search.google.com/test/rich-results) and paste the post URL to verify

schema is now recognized.

44. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/

Rule: tier2.schema.none

What it means (plain English)

https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/
https://search.google.com/test/rich-results)
https://greenleafwellness.com/nevada-weed-laws-for-tourists/
https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/


Your blog post about things to do in Reno doesn't have structured data—a special code block that tells Google

what your content is about. Without it, search engines have to guess whether you're writing a guide, a news

article, or a listicle, and they often guess wrong. This costs you visibility in Google's rich results (the fancy

cards that appear at the top of search).

Why it matters for your business: Cannabis retailers rely on local search traffic; missing schema means you're

invisible in Google Maps, local pack results, and knowledge panels where customers discover dispensaries—

directly losing foot traffic and online orders.

Technical root cause: The page HTML contains no JSON-LD blocks (the <script type="application/ld+json">

tags). WordPress doesn't add schema automatically; you need a plugin or manual markup.

Recommended fix — step by step

1. Install Yoast SEO or Rank Math (both are free tier + support cannabis retail): Dashboard → Plugins → Add

New → search 'Yoast SEO' → Install & Activate.

2. Open the blog post in WordPress editor → scroll to the Yoast/Rank Math sidebar → look for 'Schema' or

'Structured Data' tab.

3. Verify the plugin has auto-detected 'BlogPosting' or 'Article' schema; if not, manually select it from the

schema dropdown.

4. Ensure the plugin has filled in: headline (title), datePublished, author, and mainImage. Edit the post's

featured image if blank.

5. Save and publish; wait 30 seconds, then open https://validator.schema.org/ and paste the page URL to

confirm the schema block is live.

6. Repeat for all blog posts in your content library (search for posts without Yoast/Rank Math schema

indicators).

45. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/

Rule: tier2.meta.no-description

What it means (plain English)

This page is missing a meta description — the 155-character summary that appears below your page title in

Google search results. Without it, Google will auto-generate one from your page text, which is often choppy or

irrelevant and gets fewer clicks.

Why it matters for your business: Missing descriptions reduce click-through rates from search results,

meaning fewer visitors find your dispensary even when ranking well for 'closest dispensary to airport' and

similar high-intent queries.

Technical root cause: The WordPress page/post was published without filling in the meta description field

(typically in Yoast SEO, All in One SEO, or the native WordPress block editor 'Excerpt' field).

Recommended fix — step by step

1. Log into WordPress admin → Pages/Posts → find 'Burning Man Closest Dispensary' post

2. If using Yoast SEO: scroll to 'Yoast SEO' metabox → click 'Snippet' preview → enter meta description field

with 155 characters (e.g., 'Find the nearest cannabis dispensary to the airport near Burning Man. Open now

with in-stock products and directions.').

https://validator.schema.org/
https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/


3. If using All in One SEO: look for 'All in One SEO' metabox on the edit screen → 'Meta Description' field →

enter same text

4. If using native WordPress: scroll down to 'Excerpt' field and enter the description there (themes vary;

confirm your SEO plugin reads from Excerpt)

5. Repeat for other high-traffic pages identified in your analytics (e.g., product pages, location pages, FAQs)

6. Click 'Update' and verify the meta description appears in Google's rich snippet preview within your SEO

plugin

46. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/are-edibles-legal-in-nevada/

Rule: tier2.schema.none

What it means (plain English)

Your article page doesn't include JSON-LD structured data — machine-readable code that tells search engines

what your content is about. Google uses this to understand your page better and can display richer results (like

star ratings or article summaries) in search results.

Why it matters for your business: Without structured data, your cannabis product and educational content are

less likely to appear as featured snippets or rich results in Google Search, reducing visibility and click-through

rates from potential customers searching for Nevada cannabis information.

Technical root cause: The WordPress theme or content management setup is not outputting schema.org

JSON-LD blocks. Most modern WordPress SEO plugins (Yoast, Rank Math, All in One SEO) can auto-generate

these, but none are active or configured on this site.

Recommended fix — step by step

1. Install and activate Yoast SEO Free (wordpress.org/plugins/wordpress-seo) — it auto-generates Article

schema for blog posts.

2. Log into WordPress Admin → Yoast SEO → General → scroll to 'Titles & Metas' and confirm 'Show in search

results' is enabled.

3. Go to the article page in WordPress Editor, scroll to the Yoast box at the bottom, and check 'Show in Search

Results' is toggled ON.

4. Visit https://www.google.com/webmasters/markup-helper and paste your article URL to preview the schema

Yoast generates.

5. Submit the updated URL to Google Search Console (Property → URL Inspection → Request Indexing) to re-

crawl with schema data.

47. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/

Rule: tier2.meta.no-description

https://greenleafwellness.com/are-edibles-legal-in-nevada/
https://www.google.com/webmasters/markup-helper
https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/


What it means (plain English)

This blog post page has no meta description — the 160-character summary that appears below the page title in

Google search results. Without it, Google will auto-generate a snippet from page content, which may be

incomplete or off-topic and reduces click-through rate.

Why it matters for your business: Potential customers searching for Nevada dispensary regulations won't see

a compelling preview of your answer in search results, lowering clicks and traffic to this informational page.

Technical root cause: The WordPress post or page template is either missing the meta description field

entirely, or the field was left blank during publication.

Recommended fix — step by step

1. Log in to WordPress admin → go to Posts → find 'can-you-go-to-more-than-one-dispensary-a-day-in-

nevada'

2. Scroll to the SEO meta box (typically at the bottom; if absent, install Yoast SEO or RankMath plugin first)

3. Click 'Edit snippet' or the meta description field

4. Write a clear, benefit-focused description under 160 characters: e.g., 'Learn the daily visit limits for Nevada

cannabis dispensaries and how multi-dispensary shopping works.'

5. Click Update/Save

6. Audit 5-10 other high-traffic posts using a WordPress SEO plugin dashboard (Yoast or RankMath shows all

missing descriptions in bulk)

48. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/how-much-is-an-ounce-of-weed/

Rule: tier2.schema.none

What it means (plain English)

Your product and informational pages don't include structured data — machine-readable code that tells Google

what your content is about. Without it, search engines have to guess whether a page is a product listing, a blog

post, or something else, which means they may not display your content optimally in search results or show rich

snippets (like star ratings, pricing, or FAQs).

Why it matters for your business: Missing schema data reduces your chances of appearing in Google's

featured snippets, knowledge panels, and rich search results — all of which drive traffic to cannabis retail sites

and increase click-through rates from search.

Technical root cause: WordPress installations do not automatically generate JSON-LD schema markup.

Without a plugin or manual template edits, pages contain no structured data blocks that search engines can

parse.

Recommended fix — step by step

1. Install and activate the Yoast SEO plugin (free version includes basic schema) or Rank Math SEO (both

available from WordPress admin → Plugins → Add New).

2. For Yoast: Go to Yoast SEO → Site Structure, enable Schema output, and set your site type to 'Local

Business'; for the /how-much-is-an-ounce-of-weed/ page, edit it and set Schema type to 'Article' in the

Yoast sidebar.

https://greenleafwellness.com/how-much-is-an-ounce-of-weed/


3. For Rank Math: Go to Rank Math → Schema, enable Auto Schema, and configure 'Article' and

'LocalBusiness' schema in the schema builder.

4. Test the /how-much-is-an-ounce-of-weed/ page in Google's Rich Results Test

(https://search.google.com/test/rich-results) to confirm schema is now present and valid.

5. Repeat schema configuration for key pages: product pages (set as 'Product' schema with price, availability,

review data), FAQs (use 'FAQPage' schema if applicable), and your homepage (use 'LocalBusiness' with

address, phone, hours).

49. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/aether-gardens/

Rule: tier2.schema.none

What it means (plain English)

Your product pages (like the Aether Gardens page) don't include JSON-LD structured data — a machine-

readable format that tells search engines what content is on the page. Without it, Google can't confidently

understand that you're listing a cannabis product with pricing, availability, and dispensary details, so it can't

display rich search results (like star ratings or price cards).

Why it matters for your business: Missing schema means you lose visibility in Google Shopping, product rich

results, and local search features — costing you clicks from high-intent customers searching for specific strains

or products.

Technical root cause: WordPress sites using basic page builders or theme templates often don't automatically

generate schema.org markup. The page is rendering HTML but lacks the <script type="application/ld+json">

blocks that search engines rely on.

Recommended fix — step by step

1. Install the Yoast SEO plugin (free version) via WordPress admin → Plugins → Add New, search 'Yoast SEO',

click Install and Activate.

2. Go to Yoast SEO → Settings → Site connections and verify Google Search Console is connected (you'll need

your GSC property URL).

3. Edit the Aether Gardens product page and scroll to the Yoast SEO meta box at the bottom; under 'Schema',

select 'Product' from the Content type dropdown.

4. Fill in the Product schema fields: title, description, price (if listed), currency, availability status (in stock / out

of stock), and product category.

5. Repeat for 3–5 of your top product pages to test; publish and wait 48 hours, then check Google Search

Console → Rich Results to confirm schema is being indexed.

6. If Yoast doesn't auto-detect pricing or images, use the Yoast SEO block editor sidebar to manually set these

fields before publishing.

7. Consider installing the WooCommerce plugin if you plan to sell directly — it auto-generates product schema

for cart items.

50. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

https://search.google.com/test/rich-results)
https://greenleafwellness.com/aether-gardens/


Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/

Rule: tier2.schema.none

What it means (plain English)

Your website isn't using JSON-LD structured data — a standardized format that tells Google what your content

is about (e.g., a product, a business location, an article). Without it, search engines have to guess your content

type, which can hurt visibility in search results and prevent rich snippets (star ratings, prices, availability) from

appearing.

Why it matters for your business: Missing schema markup reduces your chances of appearing in Google's

knowledge panels, local pack (map results), and product carousels — all high-traffic entry points for cannabis

retail searches.

Technical root cause: WordPress isn't automatically outputting structured data markup in the page head or

body. Either no schema plugin is installed, or existing schema isn't configured for this content type.

Recommended fix — step by step

1. Install the free 'Yoast SEO' plugin (Plugins → Add New → search 'Yoast SEO' → Install & Activate)

2. Go to Yoast SEO → Dashboard → see if Basic schema is enabled; if not, turn it on

3. Visit Yoast SEO → Settings → XML Sitemaps → confirm Organization schema is filled in with your business

name, address, phone, and logo URL

4. Go to the affected page (Ski Resorts near Reno) → edit it → scroll to Yoast meta box at bottom → under

'Content type' select 'Article' or 'Blog Post' (whichever applies)

5. Optionally add a custom schema via Yoast SEO → Settings → Schema → Local Business if this is a location

page

6. Save and republish the page

7. Test the page at https://schema.org/validator or Google's Rich Results Test to confirm schema is now

present

51. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about vape carts has no structured data—machine-readable code that tells Google what type of

content this is (a review, article, product listing, etc.). Without it, search engines have to guess the page's

purpose, which reduces the chance they'll show it for relevant searches or display it with rich formatting (star

ratings, prices, snippets).

Why it matters for your business: Missing schema means lower click-through rates from search results and

reduced visibility for product-related queries that drive traffic to your retail site.

Technical root cause: WordPress isn't automatically generating JSON-LD schema.org markup for this post.

Either the active theme doesn't include schema generation, or an SEO plugin isn't configured to output it.

https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/
https://schema.org/validator
https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/


Recommended fix — step by step

1. Install Yoast SEO plugin (if not already active): Plugins → Add New → search 'Yoast SEO' → Install & Activate

2. Go to Yoast SEO → Settings → General, verify 'XML sitemaps' and 'Schema' are enabled

3. Navigate to the affected post (top-7-best-vape-carts-in-nevada) in the editor, scroll down to the Yoast meta

box, set 'Content type' to 'Article' or 'Product' (whichever fits best)

4. In Yoast's Schema settings, ensure 'Article' schema is toggled on for blog posts

5. Publish/update the post, then test in Google's Rich Results Test (search.google.com/test/rich-results) —

paste the URL and verify schema appears

6. Repeat for other high-traffic product/review posts

52. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog post about things to do in Reno doesn't include a meta description — the 155-character summary that

appears below the page title in Google search results. Without it, Google generates a random excerpt from your

content, which often looks unprofessional and may not highlight why someone should click.

Why it matters for your business: Missing meta descriptions lower click-through rates from search results,

meaning fewer visitors discover your content even when the page ranks well, and potential customers may not

realize the post is relevant to their needs.

Technical root cause: The WordPress page or post was created without filling in the SEO meta description

field, or the field was left blank during publishing.

Recommended fix — step by step

1. Log in to WordPress → go to Pages or Posts → open 'things-to-do-in-reno-nevada-2023'

2. If using Yoast SEO: scroll to the Yoast SEO meta box at the bottom → click in the 'Snippet preview' area →

type a 155-character description that includes 'Greenleaf Wellness' and a call-to-action (e.g., 'Discover the

best things to do in Reno, Nevada 2023 + cannabis-friendly activities. Visit Greenleaf Wellness for local

tips.')

3. If using Rank Math: click the Rank Math panel on the right → fill the 'Meta Description' field with 155

characters max

4. If not using an SEO plugin: edit the page HTML and add <meta name="description" content="Your 155-char

description here"> in the head section, or install Yoast SEO (free version) and use step 2

5. Save and publish the post

53. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/

https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/
https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/


Rule: tier2.schema.none

What it means (plain English)

Your page doesn't include JSON-LD structured data — machine-readable code that tells Google what your

content is about. For a cannabis retail site, this means search engines can't reliably understand product details,

location, hours, or licensing info, which hurts your visibility in local search and product results.

Why it matters for your business: Without schema markup, you're losing local search visibility and qualified

traffic from customers searching 'dispensary near me' or specific product categories — and you're not helping

Google validate compliance signals like age restrictions or license status.

Technical root cause: The page is published as plain HTML/text with no JSON-LD blocks. WordPress doesn't

auto-generate schema for cannabis content; it must be manually added via plugin or theme code.

Recommended fix — step by step

1. Install the Yoast SEO plugin (free version minimum) — go to WordPress Admin → Plugins → Add New, search

'Yoast SEO', click Install & Activate

2. In Yoast SEO settings (Sidebar → SEO → Settings), enable the Schema settings tab and ensure

'Organization' schema is turned on

3. On the affected post (Burning Man Closest Dispensary...), open the Yoast SEO metabox → Schema tab, and

explicitly set the content type to 'Product' or 'Article' + add organization schema

4. For this specific post, add a custom JSON-LD block at the top using the Code Snippets plugin (Admin →

Snippets) or manually via functions.php to include LocalBusiness schema with your license number, hours,

and age gate language

5. Validate the result using Google's Rich Results Test (search.google.com/test/rich-results) — paste the URL

and confirm Organization + LocalBusiness schema appears

54. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/

Rule: tier2.schema.none

What it means (plain English)

Your blog post about Nevada dispensary rules has no structured data markup—invisible labels that tell Google

what your content is about. Without it, search engines have to guess whether you're a news article, a guide, or

marketing copy, and they often guess wrong. This makes your content less likely to appear in rich search results

(like knowledge panels or featured snippets).

Why it matters for your business: Missing schema markup reduces your visibility in Google Search results for

informational queries, which drives qualified traffic to your dispensary and builds trust with customers

researching local regulations.

Technical root cause: WordPress doesn't automatically add JSON-LD schema to blog posts. Most SEO plugins

(Yoast, Rank Math, All in One SEO) include schema tools, but they're either not installed, not configured, or set

to a generic default that doesn't match your content type.

Recommended fix — step by step

https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/


1. Install Yoast SEO plugin (if not already active): WordPress Admin → Plugins → Add New → search 'Yoast

SEO' → Install and Activate

2. Go to Yoast SEO → Settings → Integration → toggle 'Enable XML sitemaps' on (ensures schema works with

search engines)

3. Edit the affected blog post → Yoast SEO metabox (bottom right) → set 'Content Type' dropdown to

'BlogPosting' and fill 'Focus Keyphrase' field with your target phrase (e.g., 'Nevada dispensary laws')

4. In that same post edit screen, check that the Yoast readability score is green; it will generate proper Article

schema automatically

5. Repeat for your other blog posts about cannabis regulations, licensing, or local rules

6. Optional: Go to Yoast SEO → Schema → toggle 'Enable Organization schema' and fill in your dispensary

name, phone, and address to appear in a knowledge panel

7. Submit the post URL to Google Search Console (GSC) → URL Inspection → Request Indexing to refresh

schema recognition

55. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

56. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/slurricane-strain/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

57. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/marys-medicinals/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

58. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/

Rule: tier2.meta.no-description

https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/
https://greenleafwellness.com/slurricane-strain/
https://greenleafwellness.com/marys-medicinals/
https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/


Detail

Page has no meta description.

59. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/mojave-flower/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

60. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/aether-gardens/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

61. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/kuno-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

62. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/srene-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

63. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/srene-cannabis/

Rule: tier2.schema.none

Detail

https://greenleafwellness.com/mojave-flower/
https://greenleafwellness.com/aether-gardens/
https://greenleafwellness.com/kuno-cannabis/
https://greenleafwellness.com/srene-cannabis/
https://greenleafwellness.com/srene-cannabis/


Page has no JSON-LD structured data blocks.

64. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

65. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

66. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/best-dispensaries-in-nevada-2023/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

67. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/nevada-weed-laws-for-tourists/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

68. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/nugget-rib-cook-off-2023/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/
https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/
https://greenleafwellness.com/best-dispensaries-in-nevada-2023/
https://greenleafwellness.com/nevada-weed-laws-for-tourists/
https://greenleafwellness.com/nugget-rib-cook-off-2023/


69. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/nugget-rib-cook-off-2023/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

70. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/are-edibles-legal-in-nevada/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

71. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

72. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

73. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/nugget-rib-cook-off-2023/
https://greenleafwellness.com/are-edibles-legal-in-nevada/
https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/
https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/
https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/


74. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

75. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/reno-weed-culture/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

76. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/reno-weed-culture/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

77. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

78. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/
https://greenleafwellness.com/reno-weed-culture/
https://greenleafwellness.com/reno-weed-culture/
https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/
https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/


79. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

80. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

81. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/medical-marijuana-card-in-nevada/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

82. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/medical-marijuana-card-in-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

83. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/
https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/
https://greenleafwellness.com/medical-marijuana-card-in-nevada/
https://greenleafwellness.com/medical-marijuana-card-in-nevada/
https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/


84. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

85. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/from-nevada-to-california-with-weed/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

86. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/from-nevada-to-california-with-weed/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

87. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-bachelorette-party-guide/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

88. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-bachelorette-party-guide/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/
https://greenleafwellness.com/from-nevada-to-california-with-weed/
https://greenleafwellness.com/from-nevada-to-california-with-weed/
https://greenleafwellness.com/cannabis-bachelorette-party-guide/
https://greenleafwellness.com/cannabis-bachelorette-party-guide/


89. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-edibles-sparks/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

90. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-edibles-sparks/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

91. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

92. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

93. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/seasonal-cannabis-product-guide/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/cannabis-edibles-sparks/
https://greenleafwellness.com/cannabis-edibles-sparks/
https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/
https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/
https://greenleafwellness.com/seasonal-cannabis-product-guide/


94. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/seasonal-cannabis-product-guide/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

95. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/thc-edible-dosing-for-beginners/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

96. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/thc-edible-dosing-for-beginners/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

97. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

98. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/seasonal-cannabis-product-guide/
https://greenleafwellness.com/thc-edible-dosing-for-beginners/
https://greenleafwellness.com/thc-edible-dosing-for-beginners/
https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/
https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/


99. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

100. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

101. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

102. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

103. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/
https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/
https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/
https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/
https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/


104. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

105. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

106. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

107. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

108. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/
https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/
https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/
https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/
https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/


109. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/indica-vs-sativa-effects/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

110. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/indica-vs-sativa-effects/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

111. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/gorilla-glue-strain/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

112. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/gorilla-glue-strain/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

113. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-long-do-edibles-last/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/indica-vs-sativa-effects/
https://greenleafwellness.com/indica-vs-sativa-effects/
https://greenleafwellness.com/gorilla-glue-strain/
https://greenleafwellness.com/gorilla-glue-strain/
https://greenleafwellness.com/how-long-do-edibles-last/


114. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-long-do-edibles-last/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

115. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/best-dispensary-near-me/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

116. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/best-dispensary-near-me/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

117. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/medical-marijuana-dispensaries/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

118. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/medical-marijuana-dispensaries/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/how-long-do-edibles-last/
https://greenleafwellness.com/best-dispensary-near-me/
https://greenleafwellness.com/best-dispensary-near-me/
https://greenleafwellness.com/medical-marijuana-dispensaries/
https://greenleafwellness.com/medical-marijuana-dispensaries/


119. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-much-is-an-eighth/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

120. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-much-is-an-eighth/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

121. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/the-dispensary-reno/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

122. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/the-dispensary-reno/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

123. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-dispensary-near-me/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/how-much-is-an-eighth/
https://greenleafwellness.com/how-much-is-an-eighth/
https://greenleafwellness.com/the-dispensary-reno/
https://greenleafwellness.com/the-dispensary-reno/
https://greenleafwellness.com/cannabis-dispensary-near-me/


124. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-dispensary-near-me/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

125. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/what-is-live-rosin/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

126. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/what-is-live-rosin/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

127. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/what-is-bho/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

128. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/what-is-bho/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/cannabis-dispensary-near-me/
https://greenleafwellness.com/what-is-live-rosin/
https://greenleafwellness.com/what-is-live-rosin/
https://greenleafwellness.com/what-is-bho/
https://greenleafwellness.com/what-is-bho/


129. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/best-cannabis-strains-for-beginners/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

130. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/best-cannabis-strains-for-beginners/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

131. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-to-get-medical-card/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

132. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-to-get-medical-card/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

133. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/what-is-a-dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/best-cannabis-strains-for-beginners/
https://greenleafwellness.com/best-cannabis-strains-for-beginners/
https://greenleafwellness.com/how-to-get-medical-card/
https://greenleafwellness.com/how-to-get-medical-card/
https://greenleafwellness.com/what-is-a-dispensary/


134. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/what-is-a-dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

135. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/wax-vs-shatter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

136. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/wax-vs-shatter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

137. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/best-way-to-smoke-wax/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

138. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/best-way-to-smoke-wax/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/what-is-a-dispensary/
https://greenleafwellness.com/wax-vs-shatter/
https://greenleafwellness.com/wax-vs-shatter/
https://greenleafwellness.com/best-way-to-smoke-wax/
https://greenleafwellness.com/best-way-to-smoke-wax/


139. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-to-inhale-weed-properly/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

140. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-to-inhale-weed-properly/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

141. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-long-should-a-1-g-cart-last/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

142. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-long-should-a-1-g-cart-last/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

143. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cbn-for-sleep/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/how-to-inhale-weed-properly/
https://greenleafwellness.com/how-to-inhale-weed-properly/
https://greenleafwellness.com/how-long-should-a-1-g-cart-last/
https://greenleafwellness.com/how-long-should-a-1-g-cart-last/
https://greenleafwellness.com/cbn-for-sleep/


144. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cbn-for-sleep/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

145. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/thc-and-migraines/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

146. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/thc-and-migraines/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

147. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/does-cannabis-affect-antibiotics/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

148. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/does-cannabis-affect-antibiotics/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/cbn-for-sleep/
https://greenleafwellness.com/thc-and-migraines/
https://greenleafwellness.com/thc-and-migraines/
https://greenleafwellness.com/does-cannabis-affect-antibiotics/
https://greenleafwellness.com/does-cannabis-affect-antibiotics/


149. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/does-thc-affect-antibiotics/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

150. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/does-thc-affect-antibiotics/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

151. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/nevada/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

152. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/nevada/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

153. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/what-is-cbd-vs-thc/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/does-thc-affect-antibiotics/
https://greenleafwellness.com/does-thc-affect-antibiotics/
https://greenleafwellness.com/nevada/
https://greenleafwellness.com/nevada/
https://greenleafwellness.com/what-is-cbd-vs-thc/


154. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/what-is-cbd-vs-thc/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

155. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/difference-between-indica-sativa/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

156. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/difference-between-indica-sativa/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

157. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-for-anxiety-treatment/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

158. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-for-anxiety-treatment/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/what-is-cbd-vs-thc/
https://greenleafwellness.com/difference-between-indica-sativa/
https://greenleafwellness.com/difference-between-indica-sativa/
https://greenleafwellness.com/cannabis-for-anxiety-treatment/
https://greenleafwellness.com/cannabis-for-anxiety-treatment/


159. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/best-indica-strains-for-sleep/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

160. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/best-indica-strains-for-sleep/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

161. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/glitter-bomb-strain/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

162. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/glitter-bomb-strain/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

163. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/bruce-banner-strain/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/best-indica-strains-for-sleep/
https://greenleafwellness.com/best-indica-strains-for-sleep/
https://greenleafwellness.com/glitter-bomb-strain/
https://greenleafwellness.com/glitter-bomb-strain/
https://greenleafwellness.com/bruce-banner-strain/


164. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/bruce-banner-strain/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

165. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

166. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

167. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

168. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/bruce-banner-strain/
https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/
https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/
https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/
https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/


169. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/what-is-delta-8-vs-delta-9/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

170. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/what-is-delta-8-vs-delta-9/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

171. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-strains-for-anxiety/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

172. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-strains-for-anxiety/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

173. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/where-can-i-get-my-medical-card/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/what-is-delta-8-vs-delta-9/
https://greenleafwellness.com/what-is-delta-8-vs-delta-9/
https://greenleafwellness.com/cannabis-strains-for-anxiety/
https://greenleafwellness.com/cannabis-strains-for-anxiety/
https://greenleafwellness.com/where-can-i-get-my-medical-card/


174. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/where-can-i-get-my-medical-card/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

175. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/best-edible-dosage-calculator/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

176. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/best-edible-dosage-calculator/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

177. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/best-cannabis-storage-containers/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

178. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/best-cannabis-storage-containers/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/where-can-i-get-my-medical-card/
https://greenleafwellness.com/best-edible-dosage-calculator/
https://greenleafwellness.com/best-edible-dosage-calculator/
https://greenleafwellness.com/best-cannabis-storage-containers/
https://greenleafwellness.com/best-cannabis-storage-containers/


179. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-to-roll-a-joint/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

180. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-to-roll-a-joint/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

181. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/packing-a-bowl/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

182. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/packing-a-bowl/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

183. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-to-make-cannabutter/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/how-to-roll-a-joint/
https://greenleafwellness.com/how-to-roll-a-joint/
https://greenleafwellness.com/packing-a-bowl/
https://greenleafwellness.com/packing-a-bowl/
https://greenleafwellness.com/how-to-make-cannabutter/


184. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-to-make-cannabutter/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

185. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-to-decarb-weed/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

186. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-to-decarb-weed/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

187. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/weed-strains-for-anxiety/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

188. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/weed-strains-for-anxiety/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/how-to-make-cannabutter/
https://greenleafwellness.com/how-to-decarb-weed/
https://greenleafwellness.com/how-to-decarb-weed/
https://greenleafwellness.com/weed-strains-for-anxiety/
https://greenleafwellness.com/weed-strains-for-anxiety/


189. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/what-strain-is-blue-dream/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

190. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/what-strain-is-blue-dream/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

191. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-to-properly-smoke/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

192. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-to-properly-smoke/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

193. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/what-strain-is-blue-dream/
https://greenleafwellness.com/what-strain-is-blue-dream/
https://greenleafwellness.com/how-to-properly-smoke/
https://greenleafwellness.com/how-to-properly-smoke/
https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/


194. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

195. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

196. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

197. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/does-indica-make-you-hungry/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

198. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/does-indica-make-you-hungry/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/
https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/
https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/
https://greenleafwellness.com/does-indica-make-you-hungry/
https://greenleafwellness.com/does-indica-make-you-hungry/


199. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/good-strains-for-adhd/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

200. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/good-strains-for-adhd/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

201. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

202. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

203. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/contact/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/good-strains-for-adhd/
https://greenleafwellness.com/good-strains-for-adhd/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/contact/


204. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/contact/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

205. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/module-list/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

206. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/module-list/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

207. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/blog/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

208. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/blog/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

https://greenleafwellness.com/contact/
https://greenleafwellness.com/module-list/
https://greenleafwellness.com/module-list/
https://greenleafwellness.com/blog/
https://greenleafwellness.com/blog/


209. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/blog/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

210. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/about/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

211. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/about/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

212. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/policies/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

213. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/policies/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/blog/
https://greenleafwellness.com/about/
https://greenleafwellness.com/about/
https://greenleafwellness.com/policies/
https://greenleafwellness.com/policies/


214. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/old-rewards-menu/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

215. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/old-rewards-menu/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

216. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/shop-delivery/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

217. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/shop-delivery/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

218. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/faq/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/old-rewards-menu/
https://greenleafwellness.com/old-rewards-menu/
https://greenleafwellness.com/shop-delivery/
https://greenleafwellness.com/shop-delivery/
https://greenleafwellness.com/faq/


219. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/faq/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

220. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

221. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

222. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

223. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/faq/
https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/


224. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

225. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

226. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-

89436/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

227. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-

89436/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

228. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-

89502/

Rule: tier2.meta.no-description

Detail

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/


Page has no meta description.

229. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-

89502/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

230. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

231. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

232. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

233. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/

Rule: tier2.schema.none

Detail

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/
https://greenleafwellness.com/recreational/
https://greenleafwellness.com/recreational/


Page has no JSON-LD structured data blocks.

234. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-

89440/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

235. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-

89440/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

236. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-

dispensary/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

237. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-

dispensary/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

238. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-flower/

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/cannabis-flower/


Rule: tier2.meta.no-description

Detail

Page has no meta description.

239. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-flower/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

240. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-vapes-and-carts/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

241. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-vapes-and-carts/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

242. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

243. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-edibles/

Rule: tier2.schema.none

https://greenleafwellness.com/cannabis-flower/
https://greenleafwellness.com/cannabis-vapes-and-carts/
https://greenleafwellness.com/cannabis-vapes-and-carts/
https://greenleafwellness.com/cannabis-edibles/
https://greenleafwellness.com/cannabis-edibles/


Detail

Page has no JSON-LD structured data blocks.

244. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/pre-rolls/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

245. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/pre-rolls/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

246. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-concentrates/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

247. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-concentrates/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

248. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-beverages-thc-drinks/

Rule: tier2.meta.no-description

Detail

https://greenleafwellness.com/pre-rolls/
https://greenleafwellness.com/pre-rolls/
https://greenleafwellness.com/cannabis-concentrates/
https://greenleafwellness.com/cannabis-concentrates/
https://greenleafwellness.com/cannabis-beverages-thc-drinks/


Page has no meta description.

249. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/cannabis-beverages-thc-drinks/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

250. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

251. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

252. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

253. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/cannabis-beverages-thc-drinks/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/
https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/
https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/


254. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

255. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

256. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brands/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

257. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brands/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

258. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/ios-app-android-app/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/
https://greenleafwellness.com/brands/
https://greenleafwellness.com/brands/
https://greenleafwellness.com/ios-app-android-app/


259. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/ios-app-android-app/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

260. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/deals-discounts/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

261. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/deals-discounts/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

262. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/budtender/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

263. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/budtender/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/ios-app-android-app/
https://greenleafwellness.com/deals-discounts/
https://greenleafwellness.com/deals-discounts/
https://greenleafwellness.com/budtender/
https://greenleafwellness.com/budtender/


264. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

265. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

266. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

267. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

268. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/
https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/
https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/
https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/
https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/


269. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

270. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

271. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

272. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/wyld-gummies/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

273. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/wyld-gummies/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/
https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/
https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/
https://greenleafwellness.com/brand/wyld-gummies/
https://greenleafwellness.com/brand/wyld-gummies/


274. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/rove-cartridges/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

275. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/rove-cartridges/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

276. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/stiiizy/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

277. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/stiiizy/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

278. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/marys-medicinals/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/brand/rove-cartridges/
https://greenleafwellness.com/brand/rove-cartridges/
https://greenleafwellness.com/brand/stiiizy/
https://greenleafwellness.com/brand/stiiizy/
https://greenleafwellness.com/brand/marys-medicinals/


279. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/marys-medicinals/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

280. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/cannabiotix/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

281. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/cannabiotix/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

282. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/resin8/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

283. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/resin8/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/brand/marys-medicinals/
https://greenleafwellness.com/brand/cannabiotix/
https://greenleafwellness.com/brand/cannabiotix/
https://greenleafwellness.com/brand/resin8/
https://greenleafwellness.com/brand/resin8/


284. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/binske-cannabis-products/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

285. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/binske-cannabis-products/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

286. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/packwoods/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

287. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/packwoods/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

288. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/kosmik-edibles/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/brand/binske-cannabis-products/
https://greenleafwellness.com/brand/binske-cannabis-products/
https://greenleafwellness.com/brand/packwoods/
https://greenleafwellness.com/brand/packwoods/
https://greenleafwellness.com/brand/kosmik-edibles/


289. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/kosmik-edibles/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

290. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/mojave-flower/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

291. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/mojave-flower/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

292. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/camp-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

293. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/camp-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/brand/kosmik-edibles/
https://greenleafwellness.com/brand/mojave-flower/
https://greenleafwellness.com/brand/mojave-flower/
https://greenleafwellness.com/brand/camp-cannabis/
https://greenleafwellness.com/brand/camp-cannabis/


294. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/aether-gardens/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

295. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/aether-gardens/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

296. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/kuno-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

297. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/kuno-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

298. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/srene-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/brand/aether-gardens/
https://greenleafwellness.com/brand/aether-gardens/
https://greenleafwellness.com/brand/kuno-cannabis/
https://greenleafwellness.com/brand/kuno-cannabis/
https://greenleafwellness.com/brand/srene-cannabis/


299. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/srene-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

300. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/matrix-nv/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

301. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/matrix-nv/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

302. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/nlvo/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

303. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/nlvo/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/brand/srene-cannabis/
https://greenleafwellness.com/brand/matrix-nv/
https://greenleafwellness.com/brand/matrix-nv/
https://greenleafwellness.com/brand/nlvo/
https://greenleafwellness.com/brand/nlvo/


304. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/sip-elixirs/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

305. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/sip-elixirs/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

306. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/vert-unlimited/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

307. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/vert-unlimited/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

308. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/green-leaf-productions/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/brand/sip-elixirs/
https://greenleafwellness.com/brand/sip-elixirs/
https://greenleafwellness.com/brand/vert-unlimited/
https://greenleafwellness.com/brand/vert-unlimited/
https://greenleafwellness.com/brand/green-leaf-productions/


309. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/green-leaf-productions/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

310. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/polaris-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

311. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/polaris-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

312. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/vada-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

313. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/vada-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/brand/green-leaf-productions/
https://greenleafwellness.com/brand/polaris-cannabis/
https://greenleafwellness.com/brand/polaris-cannabis/
https://greenleafwellness.com/brand/vada-cannabis/
https://greenleafwellness.com/brand/vada-cannabis/


314. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/brand/the-real-mccoy-cannabis/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

315. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/brand/the-real-mccoy-cannabis/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

316. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/category/uncategorized/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

317. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/category/uncategorized/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

318. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/category/uncategorized/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/brand/the-real-mccoy-cannabis/
https://greenleafwellness.com/brand/the-real-mccoy-cannabis/
https://greenleafwellness.com/category/uncategorized/
https://greenleafwellness.com/category/uncategorized/
https://greenleafwellness.com/category/uncategorized/


319. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/category/education/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

320. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/category/education/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

321. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/category/education/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

322. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/category/products-brands/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

323. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/category/products-brands/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

https://greenleafwellness.com/category/education/
https://greenleafwellness.com/category/education/
https://greenleafwellness.com/category/education/
https://greenleafwellness.com/category/products-brands/
https://greenleafwellness.com/category/products-brands/


324. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/category/products-brands/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

325. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/category/strains/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

326. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/category/strains/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

327. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/category/strains/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

328. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/category/events/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

https://greenleafwellness.com/category/products-brands/
https://greenleafwellness.com/category/strains/
https://greenleafwellness.com/category/strains/
https://greenleafwellness.com/category/strains/
https://greenleafwellness.com/category/events/


329. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/category/events/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

330. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/category/events/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

331. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/author/andrewlz/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

332. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/author/andrewlz/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

333. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/author/andrewlz/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

https://greenleafwellness.com/category/events/
https://greenleafwellness.com/category/events/
https://greenleafwellness.com/author/andrewlz/
https://greenleafwellness.com/author/andrewlz/
https://greenleafwellness.com/author/andrewlz/


334. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/author/cannaplanners/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

335. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/author/cannaplanners/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

336. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/author/cannaplanners/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

337. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/author/jhammer/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

338. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/author/jhammer/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

https://greenleafwellness.com/author/cannaplanners/
https://greenleafwellness.com/author/cannaplanners/
https://greenleafwellness.com/author/cannaplanners/
https://greenleafwellness.com/author/jhammer/
https://greenleafwellness.com/author/jhammer/


339. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/author/jhammer/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

340. Missing meta description

Severity: P2

Page URL: https://greenleafwellness.com/author/slash/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

341. Missing canonical

Severity: P2

Page URL: https://greenleafwellness.com/author/slash/

Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

342. No JSON-LD schema

Severity: P2

Page URL: https://greenleafwellness.com/author/slash/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

343. Layout shift (mobile): 0.123

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier3.cwv.cls-mobile

Detail

CLS 0.123 exceeds 0.05 target.

https://greenleafwellness.com/author/jhammer/
https://greenleafwellness.com/author/slash/
https://greenleafwellness.com/author/slash/
https://greenleafwellness.com/author/slash/
https://greenleafwellness.com/


344. No H1 on homepage

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier4.h1.missing

Detail

Every page should have exactly one H1.

345. Missing core schema types: Organization, LocalBusiness, WebSite

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier4.schema.missing-core

Detail

Every site should emit Organization + LocalBusiness + WebSite JSON-LD.

346. Missing security header: strict-transport-security

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier5.header.strict-transport-security

Detail

strict-transport-security not present on homepage response. Affects fortress score and CSP posture.

347. Missing security header: x-frame-options

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier5.header.x-frame-options

Detail

x-frame-options not present on homepage response. Affects fortress score and CSP posture.

348. Missing security header: content-security-policy

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier5.header.content-security-policy

Detail

content-security-policy not present on homepage response. Affects fortress score and CSP posture.

https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/


349. No DMARC policy published

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier5.fortress.dmarc-missing

Detail

No v=DMARC1 record at _dmarc.greenleafwellness.com. Without DMARC, spoofed email from your domain is

harder to filter. Start with p=none for monitoring.

350. 46 tap targets under 44px at mobile-320

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

351. 50 tap targets under 44px at mobile-375

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

352. 50 tap targets under 44px at mobile-414

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

353. 46 tap targets under 44px at tablet-768

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/


354. A11y: Heading levels should only increase by one

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier9.a11y.heading-order

Detail

Ensure the order of headings is semantically correct

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/heading-order?application=playwright

355. A11y: All page content should be contained by landmarks (×8)

Severity: P2

Page URL: https://greenleafwellness.com/

Rule: tier9.a11y.region

Detail

Ensure all page content is contained by landmarks

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/region?application=playwright

P3 — 456 findings

1. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

2. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

https://greenleafwellness.com/
https://dequeuniversity.com/rules/axe/4.11/heading-order?application=playwright
https://greenleafwellness.com/
https://dequeuniversity.com/rules/axe/4.11/region?application=playwright
https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/
https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/


No twitter:card meta tag.

3. Title length 70 chars

Severity: P3

Page URL: https://greenleafwellness.com/wyld-gummies/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Wyld Gummies: Shop Online, View Flavors, and More – Greenleaf Wellness"

4. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/wyld-gummies/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

5. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/wyld-gummies/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

6. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/bubba-fett-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

7. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/bubba-fett-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/wyld-gummies/
https://greenleafwellness.com/wyld-gummies/
https://greenleafwellness.com/wyld-gummies/
https://greenleafwellness.com/bubba-fett-strain/
https://greenleafwellness.com/bubba-fett-strain/


8. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/rove-cartridges/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

9. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/rove-cartridges/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

10. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/rove-cartridges/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

11. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/slurricane-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

12. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/slurricane-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/rove-cartridges/
https://greenleafwellness.com/rove-cartridges/
https://greenleafwellness.com/rove-cartridges/
https://greenleafwellness.com/slurricane-strain/
https://greenleafwellness.com/slurricane-strain/


13. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/stiiizy-carts-and-flower/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

14. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/stiiizy-carts-and-flower/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

15. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/marys-medicinals/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

16. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/marys-medicinals/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

17. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/binske-cannabis-products/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/stiiizy-carts-and-flower/
https://greenleafwellness.com/stiiizy-carts-and-flower/
https://greenleafwellness.com/marys-medicinals/
https://greenleafwellness.com/marys-medicinals/
https://greenleafwellness.com/binske-cannabis-products/


18. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/binske-cannabis-products/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

19. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/binske-cannabis-products/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

20. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabiotix-cbx-products/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

21. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabiotix-cbx-products/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

22. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/resin8-cannabis-products/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/binske-cannabis-products/
https://greenleafwellness.com/binske-cannabis-products/
https://greenleafwellness.com/cannabiotix-cbx-products/
https://greenleafwellness.com/cannabiotix-cbx-products/
https://greenleafwellness.com/resin8-cannabis-products/


23. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/resin8-cannabis-products/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

24. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/resin8-cannabis-products/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

25. Title length 71 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-much-is-an-ounce-of-weed/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How Much is An Ounce of Weed? Cost, Quantity, Etc. – Greenleaf Wellness"

26. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-much-is-an-ounce-of-weed/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

27. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-much-is-an-ounce-of-weed/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/resin8-cannabis-products/
https://greenleafwellness.com/resin8-cannabis-products/
https://greenleafwellness.com/how-much-is-an-ounce-of-weed/
https://greenleafwellness.com/how-much-is-an-ounce-of-weed/
https://greenleafwellness.com/how-much-is-an-ounce-of-weed/


28. Title length 72 chars

Severity: P3

Page URL: https://greenleafwellness.com/head-cheese-strain/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Head Cheese Strain Profile – Sativa-Dominant Hybrid – Greenleaf Wellness"

29. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/head-cheese-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

30. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/head-cheese-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

31. Title length 77 chars

Severity: P3

Page URL: https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Packwoods: How much are they and are they real cannabis? – Greenleaf

Wellness"

32. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/head-cheese-strain/
https://greenleafwellness.com/head-cheese-strain/
https://greenleafwellness.com/head-cheese-strain/
https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/
https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/


33. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

34. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/kosmik-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

35. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/kosmik-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

36. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/kosmik-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

37. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/mojave-flower/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/
https://greenleafwellness.com/kosmik-edibles/
https://greenleafwellness.com/kosmik-edibles/
https://greenleafwellness.com/kosmik-edibles/
https://greenleafwellness.com/mojave-flower/


38. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/mojave-flower/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

39. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/camp-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

40. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/camp-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

41. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/camp-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

42. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/aether-gardens/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/mojave-flower/
https://greenleafwellness.com/camp-cannabis/
https://greenleafwellness.com/camp-cannabis/
https://greenleafwellness.com/camp-cannabis/
https://greenleafwellness.com/aether-gardens/


43. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/aether-gardens/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

44. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-discreet-vape-pens/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

45. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-discreet-vape-pens/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

46. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/kuno-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

47. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/kuno-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/aether-gardens/
https://greenleafwellness.com/best-discreet-vape-pens/
https://greenleafwellness.com/best-discreet-vape-pens/
https://greenleafwellness.com/kuno-cannabis/
https://greenleafwellness.com/kuno-cannabis/


48. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/srene-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

49. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/srene-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

50. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

51. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

52. Title length 83 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How to Use Cannabis Concentrates – “You don’t have to dab …”   – Greenleaf

Wellness"

https://greenleafwellness.com/srene-cannabis/
https://greenleafwellness.com/srene-cannabis/
https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/
https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/
https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/


53. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

54. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

55. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

56. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

57. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/top-7-best-edibles-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/
https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/
https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/
https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/
https://greenleafwellness.com/top-7-best-edibles-in-nevada/


58. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/top-7-best-edibles-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

59. Title length 72 chars

Severity: P3

Page URL: https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Best Cannabis Flower and Pre-Rolls in Nevada (2023) – Greenleaf Wellness"

60. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

61. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

62. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/top-7-best-edibles-in-nevada/
https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/
https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/
https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/
https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/


63. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

64. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

65. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

66. Title length 73 chars

Severity: P3

Page URL: https://greenleafwellness.com/best-dispensaries-in-nevada-2023/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "BEST MARIJUANA DISPENSARIES IN NEVADA (2024 EDITION) – Greenleaf

Wellness"

67. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-dispensaries-in-nevada-2023/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/
https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/
https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/
https://greenleafwellness.com/best-dispensaries-in-nevada-2023/
https://greenleafwellness.com/best-dispensaries-in-nevada-2023/


68. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-dispensaries-in-nevada-2023/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

69. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

70. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

71. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

72. Title length 81 chars

Severity: P3

Page URL: https://greenleafwellness.com/nevada-weed-laws-for-tourists/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Nevada Weed Laws for Tourists: What NV Visitors Need to Know – Greenleaf

Wellness"

https://greenleafwellness.com/best-dispensaries-in-nevada-2023/
https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/
https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/
https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/
https://greenleafwellness.com/nevada-weed-laws-for-tourists/


73. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/nevada-weed-laws-for-tourists/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

74. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/nevada-weed-laws-for-tourists/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

75. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/nugget-rib-cook-off-2023/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

76. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/nugget-rib-cook-off-2023/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

77. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/nevada-weed-laws-for-tourists/
https://greenleafwellness.com/nevada-weed-laws-for-tourists/
https://greenleafwellness.com/nugget-rib-cook-off-2023/
https://greenleafwellness.com/nugget-rib-cook-off-2023/
https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/


78. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

79. Title length 94 chars

Severity: P3

Page URL: https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Heading to Burning Man 2023? Visit the Closest Dispensary to the Airport! –

Greenleaf Wellness"

80. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

81. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

82. Title length 70 chars

Severity: P3

Page URL: https://greenleafwellness.com/are-edibles-legal-in-nevada/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Are Edibles Legal in Nevada? (Updated 2025 Guide) – Greenleaf Wellness"

https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/
https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/
https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/
https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/
https://greenleafwellness.com/are-edibles-legal-in-nevada/


83. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/are-edibles-legal-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

84. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/are-edibles-legal-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

85. Title length 76 chars

Severity: P3

Page URL: https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Can You Go to More Than One Dispensary a Day in Nevada? – Greenleaf

Wellness"

86. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

87. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/are-edibles-legal-in-nevada/
https://greenleafwellness.com/are-edibles-legal-in-nevada/
https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/
https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/
https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/


88. Title length 81 chars

Severity: P3

Page URL: https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Are All Dispensaries Cash Only? Need to Know Facts in Nevada – Greenleaf

Wellness"

89. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

90. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

91. Title length 72 chars

Severity: P3

Page URL: https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What Happens If You Get Caught with Weed in Nevada? – Greenleaf

Wellness"

92. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/
https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/
https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/
https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/
https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/


93. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

94. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/reno-weed-culture/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

95. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/reno-weed-culture/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

96. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

97. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/
https://greenleafwellness.com/reno-weed-culture/
https://greenleafwellness.com/reno-weed-culture/
https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/
https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/


98. Title length 84 chars

Severity: P3

Page URL: https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What is the Most You Can Purchase at a Dispensary in One Visit? – Greenleaf

Wellness"

99. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

100. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

101. Title length 77 chars

Severity: P3

Page URL: https://greenleafwellness.com/medical-marijuana-card-in-nevada/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "3 Simple Steps to Get a Medical Marijuana Card In Nevada – Greenleaf

Wellness"

102. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/medical-marijuana-card-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/
https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/
https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/
https://greenleafwellness.com/medical-marijuana-card-in-nevada/
https://greenleafwellness.com/medical-marijuana-card-in-nevada/


103. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/medical-marijuana-card-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

104. Title length 85 chars

Severity: P3

Page URL: https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Do dispensaries share information with the government in Nevada? –

Greenleaf Wellness"

105. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

106. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

107. Title length 97 chars

Severity: P3

Page URL: https://greenleafwellness.com/from-nevada-to-california-with-weed/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Can You Drive From Nevada to California With Weed? (A Cannabis Travel

Guide) – Greenleaf Wellness"

https://greenleafwellness.com/medical-marijuana-card-in-nevada/
https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/
https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/
https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/
https://greenleafwellness.com/from-nevada-to-california-with-weed/


108. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/from-nevada-to-california-with-weed/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

109. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/from-nevada-to-california-with-weed/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

110. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/from-nevada-to-california-with-weed/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

111. Title length 89 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-bachelorette-party-guide/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Ultimate Cannabis Bachelor(ette) Party Guide | 5 Tips You Can’t Miss –

Greenleaf Wellness"

112. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-bachelorette-party-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/from-nevada-to-california-with-weed/
https://greenleafwellness.com/from-nevada-to-california-with-weed/
https://greenleafwellness.com/from-nevada-to-california-with-weed/
https://greenleafwellness.com/cannabis-bachelorette-party-guide/
https://greenleafwellness.com/cannabis-bachelorette-party-guide/


113. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-bachelorette-party-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

114. Title length 81 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-edibles-sparks/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Top 7 Cannabis Edibles to Try in Sparks, Nevada (with Links) – Greenleaf

Wellness"

115. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-edibles-sparks/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

116. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-edibles-sparks/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

117. Title length 84 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis and Rental Properties in Nevada (What’s Legal in 2025) –

Greenleaf Wellness"

https://greenleafwellness.com/cannabis-bachelorette-party-guide/
https://greenleafwellness.com/cannabis-edibles-sparks/
https://greenleafwellness.com/cannabis-edibles-sparks/
https://greenleafwellness.com/cannabis-edibles-sparks/
https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/


118. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

119. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

120. Title length 94 chars

Severity: P3

Page URL: https://greenleafwellness.com/seasonal-cannabis-product-guide/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Seasonal Cannabis Product Guide (Best Picks for Every Season and Holiday)

– Greenleaf Wellness"

121. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/seasonal-cannabis-product-guide/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

122. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/seasonal-cannabis-product-guide/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/
https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/
https://greenleafwellness.com/seasonal-cannabis-product-guide/
https://greenleafwellness.com/seasonal-cannabis-product-guide/
https://greenleafwellness.com/seasonal-cannabis-product-guide/


123. Title length 99 chars

Severity: P3

Page URL: https://greenleafwellness.com/thc-edible-dosing-for-beginners/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "10 Essential Tips for Safe and Effective THC Edible Dosing: A Beginner’s

Guide – Greenleaf Wellness"

124. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/thc-edible-dosing-for-beginners/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

125. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/thc-edible-dosing-for-beginners/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

126. Title length 81 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis 101: A Beginner’s Guide to Cannabis in Reno, Nevada – Greenleaf

Wellness"

127. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/thc-edible-dosing-for-beginners/
https://greenleafwellness.com/thc-edible-dosing-for-beginners/
https://greenleafwellness.com/thc-edible-dosing-for-beginners/
https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/
https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/


128. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

129. Title length 84 chars

Severity: P3

Page URL: https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Understanding THC and CBD: The Key Cannabis Compounds Explained –

Greenleaf Wellness"

130. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

131. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

132. Title length 91 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Terpene Guide: How These Compounds Affect Your Cannabis

Experience – Greenleaf Wellness"

https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/
https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/
https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/
https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/
https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/


133. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

134. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

135. Title length 77 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Consumption Methods: Finding What Works for You – Greenleaf

Wellness"

136. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

137. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/
https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/
https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/
https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/
https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/


138. Title length 76 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis Strains Explained: Indica, Sativa, and Hybrids – Greenleaf

Wellness"

139. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

140. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

141. Title length 80 chars

Severity: P3

Page URL: https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Endocannabinoid System: How Cannabis Works in Your Body – Greenleaf

Wellness"

142. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/
https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/
https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/
https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/
https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/


143. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

144. Title length 95 chars

Severity: P3

Page URL: https://greenleafwellness.com/indica-vs-sativa-effects/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Indica vs Sativa Effects: Your Ultimate Guide to Choosing the Right Strain –

Greenleaf Wellness"

145. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/indica-vs-sativa-effects/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

146. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/indica-vs-sativa-effects/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

147. Title length 73 chars

Severity: P3

Page URL: https://greenleafwellness.com/gorilla-glue-strain/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Gorilla Glue Strain: Your Ultimate Guide to a Legend – Greenleaf Wellness"

https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/
https://greenleafwellness.com/indica-vs-sativa-effects/
https://greenleafwellness.com/indica-vs-sativa-effects/
https://greenleafwellness.com/indica-vs-sativa-effects/
https://greenleafwellness.com/gorilla-glue-strain/


148. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/gorilla-glue-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

149. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/gorilla-glue-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

150. Title length 88 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-long-do-edibles-last/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How Long Do Edibles Last? Your Complete Guide to a Predictable High –

Greenleaf Wellness"

151. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-long-do-edibles-last/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

152. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-long-do-edibles-last/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/gorilla-glue-strain/
https://greenleafwellness.com/gorilla-glue-strain/
https://greenleafwellness.com/how-long-do-edibles-last/
https://greenleafwellness.com/how-long-do-edibles-last/
https://greenleafwellness.com/how-long-do-edibles-last/


153. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-dispensary-near-me/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

154. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-dispensary-near-me/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

155. Title length 89 chars

Severity: P3

Page URL: https://greenleafwellness.com/medical-marijuana-dispensaries/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Finding Your Trusted Medical Marijuana Dispensary: A Patient’s Guide –

Greenleaf Wellness"

156. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/medical-marijuana-dispensaries/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

157. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/medical-marijuana-dispensaries/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/best-dispensary-near-me/
https://greenleafwellness.com/best-dispensary-near-me/
https://greenleafwellness.com/medical-marijuana-dispensaries/
https://greenleafwellness.com/medical-marijuana-dispensaries/
https://greenleafwellness.com/medical-marijuana-dispensaries/


158. Title length 81 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-much-is-an-eighth/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How Much Is an Eighth of Weed in Reno? Here’s What to Expect – Greenleaf

Wellness"

159. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-much-is-an-eighth/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

160. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-much-is-an-eighth/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

161. Title length 92 chars

Severity: P3

Page URL: https://greenleafwellness.com/the-dispensary-reno/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Your Guide to the Best Dispensary Reno Has to Offer: Greenleaf Wellness –

Greenleaf Wellness"

162. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/the-dispensary-reno/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/how-much-is-an-eighth/
https://greenleafwellness.com/how-much-is-an-eighth/
https://greenleafwellness.com/how-much-is-an-eighth/
https://greenleafwellness.com/the-dispensary-reno/
https://greenleafwellness.com/the-dispensary-reno/


163. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/the-dispensary-reno/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

164. Title length 73 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-dispensary-near-me/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How to Find the Perfect Cannabis Dispensary Near You – Greenleaf

Wellness"

165. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-dispensary-near-me/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

166. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-dispensary-near-me/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

167. Title length 68 chars

Severity: P3

Page URL: https://greenleafwellness.com/what-is-live-rosin/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What Is Live Rosin? A Premium Concentrate Guide – Greenleaf Wellness"

https://greenleafwellness.com/the-dispensary-reno/
https://greenleafwellness.com/cannabis-dispensary-near-me/
https://greenleafwellness.com/cannabis-dispensary-near-me/
https://greenleafwellness.com/cannabis-dispensary-near-me/
https://greenleafwellness.com/what-is-live-rosin/


168. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/what-is-live-rosin/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

169. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/what-is-live-rosin/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

170. Title length 70 chars

Severity: P3

Page URL: https://greenleafwellness.com/what-is-bho/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What Is BHO? A Practical Guide to Butane Hash Oil – Greenleaf Wellness"

171. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/what-is-bho/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

172. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/what-is-bho/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/what-is-live-rosin/
https://greenleafwellness.com/what-is-live-rosin/
https://greenleafwellness.com/what-is-bho/
https://greenleafwellness.com/what-is-bho/
https://greenleafwellness.com/what-is-bho/


173. Title length 74 chars

Severity: P3

Page URL: https://greenleafwellness.com/best-cannabis-strains-for-beginners/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Your Guide to the Best Cannabis Strains for Beginners – Greenleaf Wellness"

174. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-cannabis-strains-for-beginners/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

175. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-cannabis-strains-for-beginners/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

176. Title length 80 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-to-get-medical-card/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How to Get a Medical Card in Nevada: Your Fast & Easy Guide – Greenleaf

Wellness"

177. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-to-get-medical-card/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/best-cannabis-strains-for-beginners/
https://greenleafwellness.com/best-cannabis-strains-for-beginners/
https://greenleafwellness.com/best-cannabis-strains-for-beginners/
https://greenleafwellness.com/how-to-get-medical-card/
https://greenleafwellness.com/how-to-get-medical-card/


178. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-to-get-medical-card/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

179. Title length 91 chars

Severity: P3

Page URL: https://greenleafwellness.com/what-is-a-dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "What Is a Dispensary? Your Guide to Buying Cannabis Safely and Legally –

Greenleaf Wellness"

180. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/what-is-a-dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

181. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/what-is-a-dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

182. Title length 92 chars

Severity: P3

Page URL: https://greenleafwellness.com/wax-vs-shatter/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Wax vs Shatter: A Practical Guide to Choosing Your Cannabis Concentrate –

Greenleaf Wellness"

https://greenleafwellness.com/how-to-get-medical-card/
https://greenleafwellness.com/what-is-a-dispensary/
https://greenleafwellness.com/what-is-a-dispensary/
https://greenleafwellness.com/what-is-a-dispensary/
https://greenleafwellness.com/wax-vs-shatter/


183. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/wax-vs-shatter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

184. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/wax-vs-shatter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

185. Title length 85 chars

Severity: P3

Page URL: https://greenleafwellness.com/best-way-to-smoke-wax/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "The Best Way to Smoke Wax: A Practical Guide for the Perfect Hit –

Greenleaf Wellness"

186. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-way-to-smoke-wax/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

187. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-way-to-smoke-wax/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/wax-vs-shatter/
https://greenleafwellness.com/wax-vs-shatter/
https://greenleafwellness.com/best-way-to-smoke-wax/
https://greenleafwellness.com/best-way-to-smoke-wax/
https://greenleafwellness.com/best-way-to-smoke-wax/


188. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-to-inhale-weed-properly/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

189. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-to-inhale-weed-properly/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

190. Title length 70 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-long-should-a-1-g-cart-last/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How Long Should a 1G Cart Last? A Practical Guide – Greenleaf Wellness"

191. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-long-should-a-1-g-cart-last/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

192. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-long-should-a-1-g-cart-last/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/how-to-inhale-weed-properly/
https://greenleafwellness.com/how-to-inhale-weed-properly/
https://greenleafwellness.com/how-long-should-a-1-g-cart-last/
https://greenleafwellness.com/how-long-should-a-1-g-cart-last/
https://greenleafwellness.com/how-long-should-a-1-g-cart-last/


193. Title length 68 chars

Severity: P3

Page URL: https://greenleafwellness.com/cbn-for-sleep/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "CBN for Sleep: Your Natural Path to Better Rest – Greenleaf Wellness"

194. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cbn-for-sleep/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

195. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cbn-for-sleep/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

196. Title length 67 chars

Severity: P3

Page URL: https://greenleafwellness.com/thc-and-migraines/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Could THC Be the Answer to Your Migraine Pain? – Greenleaf Wellness"

197. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/thc-and-migraines/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/cbn-for-sleep/
https://greenleafwellness.com/cbn-for-sleep/
https://greenleafwellness.com/cbn-for-sleep/
https://greenleafwellness.com/thc-and-migraines/
https://greenleafwellness.com/thc-and-migraines/


198. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/thc-and-migraines/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

199. Title length 74 chars

Severity: P3

Page URL: https://greenleafwellness.com/does-cannabis-affect-antibiotics/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Does Cannabis Affect Antibiotics? A Guide to Safe Use – Greenleaf

Wellness"

200. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/does-cannabis-affect-antibiotics/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

201. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/does-cannabis-affect-antibiotics/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

202. Title length 72 chars

Severity: P3

Page URL: https://greenleafwellness.com/does-thc-affect-antibiotics/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Does THC Affect Antibiotics? Your Guide to Safe Use – Greenleaf Wellness"

https://greenleafwellness.com/thc-and-migraines/
https://greenleafwellness.com/does-cannabis-affect-antibiotics/
https://greenleafwellness.com/does-cannabis-affect-antibiotics/
https://greenleafwellness.com/does-cannabis-affect-antibiotics/
https://greenleafwellness.com/does-thc-affect-antibiotics/


203. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/does-thc-affect-antibiotics/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

204. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/does-thc-affect-antibiotics/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

205. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/nevada/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

206. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/nevada/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

207. Title length 83 chars

Severity: P3

Page URL: https://greenleafwellness.com/what-is-cbd-vs-thc/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "CBD vs. THC: What’s the Difference and Which is Right for You? – Greenleaf

Wellness"

https://greenleafwellness.com/does-thc-affect-antibiotics/
https://greenleafwellness.com/does-thc-affect-antibiotics/
https://greenleafwellness.com/nevada/
https://greenleafwellness.com/nevada/
https://greenleafwellness.com/what-is-cbd-vs-thc/


208. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/what-is-cbd-vs-thc/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

209. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/what-is-cbd-vs-thc/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

210. Title length 96 chars

Severity: P3

Page URL: https://greenleafwellness.com/difference-between-indica-sativa/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Indica vs. Sativa: A Practical Guide to Choosing the Right Cannabis for You –

Greenleaf Wellness"

211. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/difference-between-indica-sativa/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

212. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/difference-between-indica-sativa/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/what-is-cbd-vs-thc/
https://greenleafwellness.com/what-is-cbd-vs-thc/
https://greenleafwellness.com/difference-between-indica-sativa/
https://greenleafwellness.com/difference-between-indica-sativa/
https://greenleafwellness.com/difference-between-indica-sativa/


213. Title length 91 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-for-anxiety-treatment/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Cannabis for Anxiety Treatment: Your Practical Guide to Finding Relief –

Greenleaf Wellness"

214. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-for-anxiety-treatment/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

215. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-for-anxiety-treatment/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

216. Title length 92 chars

Severity: P3

Page URL: https://greenleafwellness.com/best-indica-strains-for-sleep/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "6 Best Indica Strains for Sleep: Your 2026 Guide to Waking Up Refreshed –

Greenleaf Wellness"

217. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-indica-strains-for-sleep/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/cannabis-for-anxiety-treatment/
https://greenleafwellness.com/cannabis-for-anxiety-treatment/
https://greenleafwellness.com/cannabis-for-anxiety-treatment/
https://greenleafwellness.com/best-indica-strains-for-sleep/
https://greenleafwellness.com/best-indica-strains-for-sleep/


218. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-indica-strains-for-sleep/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

219. Title length 71 chars

Severity: P3

Page URL: https://greenleafwellness.com/glitter-bomb-strain/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Glitter Bomb Strain: Your Guide to a Dazzling High – Greenleaf Wellness"

220. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/glitter-bomb-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

221. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/glitter-bomb-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

222. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/bruce-banner-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/best-indica-strains-for-sleep/
https://greenleafwellness.com/glitter-bomb-strain/
https://greenleafwellness.com/glitter-bomb-strain/
https://greenleafwellness.com/glitter-bomb-strain/
https://greenleafwellness.com/bruce-banner-strain/


223. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/bruce-banner-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

224. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

225. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

226. Title length 97 chars

Severity: P3

Page URL: https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Sativa vs Indica vs Hybrid: Your Ultimate Guide to Choosing the Right Strain

– Greenleaf Wellness"

227. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/bruce-banner-strain/
https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/
https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/
https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/
https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/


228. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

229. Title length 92 chars

Severity: P3

Page URL: https://greenleafwellness.com/what-is-delta-8-vs-delta-9/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Delta 8 vs Delta 9: The Ultimate Guide to Choosing What’s Right for You –

Greenleaf Wellness"

230. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/what-is-delta-8-vs-delta-9/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

231. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/what-is-delta-8-vs-delta-9/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

232. Title length 73 chars

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-strains-for-anxiety/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "8 Best Cannabis Strains for Anxiety: Your 2025 Guide – Greenleaf Wellness"

https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/
https://greenleafwellness.com/what-is-delta-8-vs-delta-9/
https://greenleafwellness.com/what-is-delta-8-vs-delta-9/
https://greenleafwellness.com/what-is-delta-8-vs-delta-9/
https://greenleafwellness.com/cannabis-strains-for-anxiety/


233. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-strains-for-anxiety/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

234. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-strains-for-anxiety/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

235. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/where-can-i-get-my-medical-card/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

236. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/where-can-i-get-my-medical-card/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

237. Title length 76 chars

Severity: P3

Page URL: https://greenleafwellness.com/best-edible-dosage-calculator/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Your Guide to Finding the Best Edible Dosage Calculator – Greenleaf

Wellness"

https://greenleafwellness.com/cannabis-strains-for-anxiety/
https://greenleafwellness.com/cannabis-strains-for-anxiety/
https://greenleafwellness.com/where-can-i-get-my-medical-card/
https://greenleafwellness.com/where-can-i-get-my-medical-card/
https://greenleafwellness.com/best-edible-dosage-calculator/


238. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-edible-dosage-calculator/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

239. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-edible-dosage-calculator/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

240. Title length 71 chars

Severity: P3

Page URL: https://greenleafwellness.com/best-cannabis-storage-containers/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Your Guide to the Best Cannabis Storage Containers – Greenleaf Wellness"

241. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/best-cannabis-storage-containers/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

242. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/best-cannabis-storage-containers/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/best-edible-dosage-calculator/
https://greenleafwellness.com/best-edible-dosage-calculator/
https://greenleafwellness.com/best-cannabis-storage-containers/
https://greenleafwellness.com/best-cannabis-storage-containers/
https://greenleafwellness.com/best-cannabis-storage-containers/


243. Title length 71 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-to-roll-a-joint/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How to Roll a Joint: The Ultimate Beginner’s Guide – Greenleaf Wellness"

244. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-to-roll-a-joint/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

245. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-to-roll-a-joint/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

246. Title length 77 chars

Severity: P3

Page URL: https://greenleafwellness.com/packing-a-bowl/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Packing a Bowl: A Step-by-Step Guide to the Perfect Burn – Greenleaf

Wellness"

247. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/packing-a-bowl/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/how-to-roll-a-joint/
https://greenleafwellness.com/how-to-roll-a-joint/
https://greenleafwellness.com/how-to-roll-a-joint/
https://greenleafwellness.com/packing-a-bowl/
https://greenleafwellness.com/packing-a-bowl/


248. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/packing-a-bowl/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

249. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-to-make-cannabutter/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

250. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-to-make-cannabutter/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

251. Title length 70 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-to-decarb-weed/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How to Decarb Weed for Perfect Edibles Every Time – Greenleaf Wellness"

252. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-to-decarb-weed/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/packing-a-bowl/
https://greenleafwellness.com/how-to-make-cannabutter/
https://greenleafwellness.com/how-to-make-cannabutter/
https://greenleafwellness.com/how-to-decarb-weed/
https://greenleafwellness.com/how-to-decarb-weed/


253. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-to-decarb-weed/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

254. Title length 70 chars

Severity: P3

Page URL: https://greenleafwellness.com/weed-strains-for-anxiety/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Find Your Calm: The Best Weed Strains for Anxiety – Greenleaf Wellness"

255. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/weed-strains-for-anxiety/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

256. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/weed-strains-for-anxiety/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

257. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/what-strain-is-blue-dream/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/how-to-decarb-weed/
https://greenleafwellness.com/weed-strains-for-anxiety/
https://greenleafwellness.com/weed-strains-for-anxiety/
https://greenleafwellness.com/weed-strains-for-anxiety/
https://greenleafwellness.com/what-strain-is-blue-dream/


258. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/what-strain-is-blue-dream/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

259. Title length 73 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-to-properly-smoke/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "A Beginner’s Guide on How to Properly Smoke Cannabis – Greenleaf

Wellness"

260. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-to-properly-smoke/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

261. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-to-properly-smoke/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

262. Title length 76 chars

Severity: P3

Page URL: https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Blue Dream Strain Sativa or Indica? Your Ultimate Guide – Greenleaf

Wellness"

https://greenleafwellness.com/what-strain-is-blue-dream/
https://greenleafwellness.com/how-to-properly-smoke/
https://greenleafwellness.com/how-to-properly-smoke/
https://greenleafwellness.com/how-to-properly-smoke/
https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/


263. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

264. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

265. Title length 76 chars

Severity: P3

Page URL: https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "How Many Grams Is an 1/8 of Weed? A Simple, Clear Guide – Greenleaf

Wellness"

266. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

267. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/
https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/
https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/
https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/
https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/


268. Title length 91 chars

Severity: P3

Page URL: https://greenleafwellness.com/does-indica-make-you-hungry/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Does Indica Make You Hungry? Unpacking the Science Behind the Munchies

– Greenleaf Wellness"

269. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/does-indica-make-you-hungry/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

270. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/does-indica-make-you-hungry/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

271. Title length 73 chars

Severity: P3

Page URL: https://greenleafwellness.com/good-strains-for-adhd/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "7 Good Strains for ADHD: Your Guide to Focus in 2026 – Greenleaf Wellness"

272. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/good-strains-for-adhd/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/does-indica-make-you-hungry/
https://greenleafwellness.com/does-indica-make-you-hungry/
https://greenleafwellness.com/does-indica-make-you-hungry/
https://greenleafwellness.com/good-strains-for-adhd/
https://greenleafwellness.com/good-strains-for-adhd/


273. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/good-strains-for-adhd/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

274. Title length 18 chars

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Greenleaf Wellness"

275. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

276. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

277. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/contact/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/good-strains-for-adhd/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/contact/


278. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/contact/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

279. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/module-list/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

280. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/module-list/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

281. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/blog/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

282. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/blog/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/contact/
https://greenleafwellness.com/module-list/
https://greenleafwellness.com/module-list/
https://greenleafwellness.com/blog/
https://greenleafwellness.com/blog/


283. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/about/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

284. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/about/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

285. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/policies/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

286. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/policies/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

287. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/old-rewards-menu/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/about/
https://greenleafwellness.com/about/
https://greenleafwellness.com/policies/
https://greenleafwellness.com/policies/
https://greenleafwellness.com/old-rewards-menu/


288. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/old-rewards-menu/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

289. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/old-rewards-menu/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

290. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/shop-delivery/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

291. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/shop-delivery/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

292. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/shop-delivery/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://greenleafwellness.com/old-rewards-menu/
https://greenleafwellness.com/old-rewards-menu/
https://greenleafwellness.com/shop-delivery/
https://greenleafwellness.com/shop-delivery/
https://greenleafwellness.com/shop-delivery/


293. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/faq/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

294. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/faq/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

295. Title length 72 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Reno Cannabis and Weed Dispensary Near Reno Airport – Greenleaf

Wellness"

296. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

297. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/faq/
https://greenleafwellness.com/faq/
https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/


298. Title length 74 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Recreational Cannabis Dispensary Near Tahoe, CA 96145 – Greenleaf

Wellness"

299. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

300. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

301. Title length 77 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Recreational Cannabis Dispensary Near McCarran, NV 89434 – Greenleaf

Wellness"

302. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/


303. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

304. Title length 84 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-

89436/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Recreational Cannabis Dispensary Near Spanish Springs, NV 89436 –

Greenleaf Wellness"

305. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-

89436/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

306. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-

89436/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

307. Title length 82 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-

89502/

Rule: tier2.meta.title-length

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/


Detail

Title should be 20-65 chars. Got: "Cannabis Dispensary and Delivery Near Hidden Valley, NV 89502 – Greenleaf

Wellness"

308. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-

89502/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

309. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-

89502/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

310. Title length 79 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Recreational Cannabis Dispensary Near Sun Valley, NV 89433 – Greenleaf

Wellness"

311. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

312. Missing Twitter card

Severity: P3

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/


Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

313. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

314. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

315. Title length 82 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-

89440/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Recreational Cannabis Dispensary Near Virginia City, NV 89440 – Greenleaf

Wellness"

316. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-

89440/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

317. Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/
https://greenleafwellness.com/recreational/
https://greenleafwellness.com/recreational/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/


Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-

89440/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

318. Title length 86 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-

dispensary/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Find The Best Casinos in Reno, NV – Visit Our Dispensary En Route –

Greenleaf Wellness"

319. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-

dispensary/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

320. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-

dispensary/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

321. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-flower/

Rule: tier2.meta.no-og

Detail

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/cannabis-flower/


Page missing og:title and/or og:image.

322. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-flower/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

323. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-vapes-and-carts/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

324. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-vapes-and-carts/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

325. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

326. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/cannabis-flower/
https://greenleafwellness.com/cannabis-vapes-and-carts/
https://greenleafwellness.com/cannabis-vapes-and-carts/
https://greenleafwellness.com/cannabis-edibles/
https://greenleafwellness.com/cannabis-edibles/


327. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/pre-rolls/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

328. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/pre-rolls/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

329. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-concentrates/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

330. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-concentrates/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

331. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-concentrates/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://greenleafwellness.com/pre-rolls/
https://greenleafwellness.com/pre-rolls/
https://greenleafwellness.com/cannabis-concentrates/
https://greenleafwellness.com/cannabis-concentrates/
https://greenleafwellness.com/cannabis-concentrates/


332. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-beverages-thc-drinks/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

333. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/cannabis-beverages-thc-drinks/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

334. Title length 80 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Recreational Cannabis Dispensary Near Carson City, NV 89701 – Greenleaf

Wellness"

335. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

336. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/cannabis-beverages-thc-drinks/
https://greenleafwellness.com/cannabis-beverages-thc-drinks/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/


337. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

338. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

339. Title length 75 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Recreational Cannabis Dispensary Near Fallon, NV 89406 – Greenleaf

Wellness"

340. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

341. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/
https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/


342. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brands/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

343. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brands/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

344. 3 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brands/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

345. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/ios-app-android-app/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

346. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/ios-app-android-app/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/brands/
https://greenleafwellness.com/brands/
https://greenleafwellness.com/brands/
https://greenleafwellness.com/ios-app-android-app/
https://greenleafwellness.com/ios-app-android-app/


347. 4 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/ios-app-android-app/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

348. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/deals-discounts/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

349. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/deals-discounts/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

350. 2 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/deals-discounts/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

351. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/budtender/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/ios-app-android-app/
https://greenleafwellness.com/deals-discounts/
https://greenleafwellness.com/deals-discounts/
https://greenleafwellness.com/deals-discounts/
https://greenleafwellness.com/budtender/


352. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/budtender/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

353. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/budtender/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

354. Title length 67 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Midtown & Downtown Reno Dispensary Alternative – Greenleaf Wellness"

355. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

356. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/budtender/
https://greenleafwellness.com/budtender/
https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/
https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/
https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/


357. Title length 72 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Spanish Springs & Wingfield Springs Dispensary Page – Greenleaf Wellness"

358. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

359. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

360. Title length 69 chars

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Sparks Marina & Victorian Square Dispensary Page – Greenleaf Wellness"

361. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/
https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/
https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/
https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/
https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/


362. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

363. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

364. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

365. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/wyld-gummies/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

366. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/wyld-gummies/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/
https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/
https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/
https://greenleafwellness.com/brand/wyld-gummies/
https://greenleafwellness.com/brand/wyld-gummies/


367. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/rove-cartridges/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

368. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/rove-cartridges/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

369. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/rove-cartridges/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

370. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/stiiizy/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

371. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/stiiizy/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/brand/rove-cartridges/
https://greenleafwellness.com/brand/rove-cartridges/
https://greenleafwellness.com/brand/rove-cartridges/
https://greenleafwellness.com/brand/stiiizy/
https://greenleafwellness.com/brand/stiiizy/


372. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/marys-medicinals/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

373. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/marys-medicinals/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

374. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/cannabiotix/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

375. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/cannabiotix/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

376. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/resin8/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/brand/marys-medicinals/
https://greenleafwellness.com/brand/marys-medicinals/
https://greenleafwellness.com/brand/cannabiotix/
https://greenleafwellness.com/brand/cannabiotix/
https://greenleafwellness.com/brand/resin8/


377. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/resin8/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

378. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/resin8/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

379. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/binske-cannabis-products/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

380. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/binske-cannabis-products/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

381. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/binske-cannabis-products/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://greenleafwellness.com/brand/resin8/
https://greenleafwellness.com/brand/resin8/
https://greenleafwellness.com/brand/binske-cannabis-products/
https://greenleafwellness.com/brand/binske-cannabis-products/
https://greenleafwellness.com/brand/binske-cannabis-products/


382. Title length 77 chars

Severity: P3

Page URL: https://greenleafwellness.com/brand/packwoods/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Packwoods: How much are they and are they real cannabis? – Greenleaf

Wellness"

383. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/packwoods/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

384. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/packwoods/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

385. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/kosmik-edibles/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

386. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/kosmik-edibles/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/brand/packwoods/
https://greenleafwellness.com/brand/packwoods/
https://greenleafwellness.com/brand/packwoods/
https://greenleafwellness.com/brand/kosmik-edibles/
https://greenleafwellness.com/brand/kosmik-edibles/


387. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/kosmik-edibles/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

388. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/mojave-flower/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

389. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/mojave-flower/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

390. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/camp-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

391. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/camp-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/brand/kosmik-edibles/
https://greenleafwellness.com/brand/mojave-flower/
https://greenleafwellness.com/brand/mojave-flower/
https://greenleafwellness.com/brand/camp-cannabis/
https://greenleafwellness.com/brand/camp-cannabis/


392. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/camp-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

393. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/aether-gardens/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

394. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/aether-gardens/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

395. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/kuno-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

396. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/kuno-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/brand/camp-cannabis/
https://greenleafwellness.com/brand/aether-gardens/
https://greenleafwellness.com/brand/aether-gardens/
https://greenleafwellness.com/brand/kuno-cannabis/
https://greenleafwellness.com/brand/kuno-cannabis/


397. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/srene-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

398. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/srene-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

399. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/srene-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

400. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/matrix-nv/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

401. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/matrix-nv/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/brand/srene-cannabis/
https://greenleafwellness.com/brand/srene-cannabis/
https://greenleafwellness.com/brand/srene-cannabis/
https://greenleafwellness.com/brand/matrix-nv/
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402. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/matrix-nv/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

403. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/nlvo/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

404. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/nlvo/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

405. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/sip-elixirs/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

406. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/sip-elixirs/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/brand/matrix-nv/
https://greenleafwellness.com/brand/nlvo/
https://greenleafwellness.com/brand/nlvo/
https://greenleafwellness.com/brand/sip-elixirs/
https://greenleafwellness.com/brand/sip-elixirs/


407. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/vert-unlimited/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

408. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/vert-unlimited/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

409. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/green-leaf-productions/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

410. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/green-leaf-productions/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

411. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/green-leaf-productions/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

https://greenleafwellness.com/brand/vert-unlimited/
https://greenleafwellness.com/brand/vert-unlimited/
https://greenleafwellness.com/brand/green-leaf-productions/
https://greenleafwellness.com/brand/green-leaf-productions/
https://greenleafwellness.com/brand/green-leaf-productions/


412. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/polaris-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

413. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/polaris-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

414. 1 image(s) missing alt text

Severity: P3

Page URL: https://greenleafwellness.com/brand/polaris-cannabis/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

415. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/vada-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

416. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/vada-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/brand/polaris-cannabis/
https://greenleafwellness.com/brand/polaris-cannabis/
https://greenleafwellness.com/brand/polaris-cannabis/
https://greenleafwellness.com/brand/vada-cannabis/
https://greenleafwellness.com/brand/vada-cannabis/


417. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/brand/the-real-mccoy-cannabis/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

418. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/brand/the-real-mccoy-cannabis/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

419. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/category/uncategorized/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

420. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/category/uncategorized/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

421. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/category/education/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/brand/the-real-mccoy-cannabis/
https://greenleafwellness.com/brand/the-real-mccoy-cannabis/
https://greenleafwellness.com/category/uncategorized/
https://greenleafwellness.com/category/uncategorized/
https://greenleafwellness.com/category/education/


422. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/category/education/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

423. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/category/products-brands/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

424. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/category/products-brands/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

425. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/category/strains/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

426. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/category/strains/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/category/education/
https://greenleafwellness.com/category/products-brands/
https://greenleafwellness.com/category/products-brands/
https://greenleafwellness.com/category/strains/
https://greenleafwellness.com/category/strains/


427. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/category/events/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

428. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/category/events/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

429. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/author/andrewlz/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

430. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/author/andrewlz/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

431. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/author/cannaplanners/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://greenleafwellness.com/category/events/
https://greenleafwellness.com/category/events/
https://greenleafwellness.com/author/andrewlz/
https://greenleafwellness.com/author/andrewlz/
https://greenleafwellness.com/author/cannaplanners/


432. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/author/cannaplanners/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

433. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/author/jhammer/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

434. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/author/jhammer/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

435. Missing OpenGraph metadata

Severity: P3

Page URL: https://greenleafwellness.com/author/slash/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

436. Missing Twitter card

Severity: P3

Page URL: https://greenleafwellness.com/author/slash/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://greenleafwellness.com/author/cannaplanners/
https://greenleafwellness.com/author/jhammer/
https://greenleafwellness.com/author/jhammer/
https://greenleafwellness.com/author/slash/
https://greenleafwellness.com/author/slash/


437. Heavy JS payload (mobile): 757KB

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier3.weight.js-mobile

Detail

JavaScript transfer exceeds 250KB budget.

438. Heavy page weight (mobile): 3910KB

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier3.weight.total-mobile

Detail

Total transfer exceeds 2500KB budget.

439. Heavy JS payload (desktop): 300KB

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier3.weight.js-desktop

Detail

JavaScript transfer exceeds 250KB budget.

440. Heavy page weight (desktop): 3492KB

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier3.weight.total-desktop

Detail

Total transfer exceeds 2500KB budget.

441. Missing security header: x-content-type-options

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier5.header.x-content-type-options

Detail

x-content-type-options not present on homepage response. Affects fortress score and CSP posture.

https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/


442. Missing security header: referrer-policy

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier5.header.referrer-policy

Detail

referrer-policy not present on homepage response. Affects fortress score and CSP posture.

443. Missing security header: permissions-policy

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier5.header.permissions-policy

Detail

permissions-policy not present on homepage response. Affects fortress score and CSP posture.

444. SSL Labs grade: unknown

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier5.fortress.ssl-grade

Detail

Qualys SSL Labs: SSL Labs HTTP 400. Aim for A+ via strong TLS 1.3, HSTS, CAA, and preload.

445. DNSSEC not enabled

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier5.fortress.dnssec-missing

Detail

DNSSEC adds cryptographic verification to DNS responses. Consider enabling via your registrar.

446. No CAA DNS records

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier5.fortress.caa-missing

Detail

CAA records restrict which CAs may issue certs for your domain, preventing rogue issuance. Add CAA for

letsencrypt.org / digicert.com / etc.

https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/


447. Lighthouse perf (mobile): 76/100

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lighthouse.perf-mobile

Detail

Score 76 is below target 85. See HTML report for details.

448. Lighthouse a11y (mobile): 88/100

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lighthouse.a11y-mobile

Detail

Score 88 is below target 95. See HTML report for details.

449. Lighthouse bestPractices (mobile): 79/100

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lighthouse.bestPractices-mobile

Detail

Score 79 is below target 90. See HTML report for details.

450. Lighthouse seo (mobile): 85/100

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lighthouse.seo-mobile

Detail

Score 85 is below target 95. See HTML report for details.

451. LH mobile: Minify JavaScript (Est savings of 5 KiB)

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lh-opportunity.unminified-javascript-mobile

Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"

rel="noreferrer">Learn how to minify JavaScript.

https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
https://greenleafwellness.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Greenleaf%20Wellness/%3Ca%20href=


452. LH mobile: Reduce unused CSS (Est savings of 12 KiB)

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lh-opportunity.unused-css-rules-mobile

Detail

Reduce unused rules from stylesheets and defer CSS not used for above-the-fold content to decrease bytes

consumed by network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-css-rules/"

target="_blank" rel="noreferrer">Learn how to reduce unused CSS.

453. LH mobile: Reduce unused JavaScript (Est savings of 49 KiB)

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lh-opportunity.unused-javascript-mobile

Detail

Reduce unused JavaScript and defer loading scripts until they are required to decrease bytes consumed by

network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-javascript/"

target="_blank" rel="noreferrer">Learn how to reduce unused JavaScript.

454. LH mobile: Serve images in next-gen formats (Est savings of 116 KiB)

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lh-opportunity.modern-image-formats-mobile

Detail

Image formats like WebP and AVIF often provide better compression than PNG or JPEG, which means faster

downloads and less data consumption. https://developer.chrome.com/docs/lighthouse/performance/uses-webp-

images/" target="_blank" rel="noreferrer">Learn more about modern image formats.

455. LH mobile: Efficiently encode images (Est savings of 8 KiB)

Severity: P3

Page URL: https://greenleafwellness.com/

Rule: tier8.lh-opportunity.uses-optimized-images-mobile

Detail

Optimized images load faster and consume less cellular data.

https://developer.chrome.com/docs/lighthouse/performance/uses-optimized-images/" target="_blank"

rel="noreferrer">Learn how to efficiently encode images.

456. Dutchie menu iframe not found on /, /menu, or /shop

Severity: P3

https://greenleafwellness.com/
file:///Users/markwallace/BKH/apex-sentinel/dashboard/public/audits/2026-04/Greenleaf%20Wellness/%3Ca%20href=
https://greenleafwellness.com/
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Page URL: https://greenleafwellness.com/

Rule: tier-revenue.dutchie.iframe-absent

Detail

No Dutchie iframe detected. If this client uses a different menu provider, add it to clients.yaml dutchieSlug=null

+ we'll stop flagging.

Findings by Page

Grouped by URL — useful when working through the site one page at a time.

https://greenleafwellness.com/

_42 findings on this page_

[P1] 120 broken internal link(s) 🔴  DO FIRST

Your site has 120 internal links pointing to pages that no longer exist (404 errors). This includes links in blog

posts like 'First Time Visiting a Dispensary in Nevada' pointing to /shop-pickup/, and

[P1] A11y: ARIA dialog and alertdialog nodes should have an accessible name 🔴  DO FIRST

Your age-gate dialog (the popup that appears when visitors first arrive) is missing a label that screen readers

can announce. Screen reader users — including visually impaired customers — cannot under

[P1] A11y: Elements must meet minimum color contrast ratio thresholds 🔴  DO FIRST

A notice banner at the top of your site uses white text (#ffffff) on a cyan background (#3ccbda), which creates

a contrast ratio of only 1.95:1. WCAG 2 AA standard requires at least 4.5:1 for normal t

[P1] A11y: Frames must have an accessible name 🔴  DO FIRST

Your site has an iframe (a window embedded in your page) that lacks a descriptive name. Screen readers used

by blind and low-vision visitors cannot identify what this iframe contains or why it's there

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] Layout shift (mobile): 0.123

[P2] No H1 on homepage

[P2] Missing core schema types: Organization, LocalBusiness, WebSite

[P2] Missing security header: strict-transport-security

[P2] Missing security header: x-frame-options

[P2] Missing security header: content-security-policy

[P2] No DMARC policy published

[P2] 46 tap targets under 44px at mobile-320

[P2] 50 tap targets under 44px at mobile-375

[P2] 50 tap targets under 44px at mobile-414

[P2] 46 tap targets under 44px at tablet-768

[P2] A11y: Heading levels should only increase by one

https://greenleafwellness.com/
https://greenleafwellness.com/


[P2] A11y: All page content should be contained by landmarks (×8)

[P3] Title length 18 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] Heavy JS payload (mobile): 757KB

[P3] Heavy page weight (mobile): 3910KB

[P3] Heavy JS payload (desktop): 300KB

[P3] Heavy page weight (desktop): 3492KB

[P3] Missing security header: x-content-type-options

[P3] Missing security header: referrer-policy

[P3] Missing security header: permissions-policy

[P3] SSL Labs grade: unknown

[P3] DNSSEC not enabled

[P3] No CAA DNS records

[P3] Lighthouse perf (mobile): 76/100

[P3] Lighthouse a11y (mobile): 88/100

[P3] Lighthouse bestPractices (mobile): 79/100

[P3] Lighthouse seo (mobile): 85/100

[P3] LH mobile: Minify JavaScript (Est savings of 5 KiB)

[P3] LH mobile: Reduce unused CSS (Est savings of 12 KiB)

[P3] LH mobile: Reduce unused JavaScript (Est savings of 49 KiB)

[P3] LH mobile: Serve images in next-gen formats (Est savings of 116 KiB)

[P3] LH mobile: Efficiently encode images (Est savings of 8 KiB)

[P3] Dutchie menu iframe not found on /, /menu, or /shop

https://greenleafwellness.com/from-nevada-to-california-with-weed/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 97 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/wyld-gummies/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your product page for Wyld Gummies is missing a meta description—a 150–160 character summary that

appears below your page title in Google search results. Without it, Google may auto-generate a snippet

[P2] No JSON-LD schema 🟠  HIGH

https://greenleafwellness.com/from-nevada-to-california-with-weed/
https://greenleafwellness.com/wyld-gummies/


Your product pages (like the Wyld Gummies page) don't include JSON-LD structured data—machine-readable

code that tells Google and other search engines exactly what your page is about. Without it, sear

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/rove-cartridges/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This product page is missing a meta description — the 160-character summary that appears under your page

title in Google search results. Without it, Google may auto-generate a snippet from your page c

[P2] No JSON-LD schema 🟠  HIGH

Your product pages are missing structured data—machine-readable labels that tell Google what your products

are, their prices, and ratings. Without this, search engines have to guess, which means your

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/binske-cannabis-products/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This product page is missing a meta description — the 160-character summary that appears under your page

title in Google search results. Without it, Google generates one automatically, which is often

[P2] No JSON-LD schema 🟠  HIGH

Your product pages lack structured data — machine-readable labels that tell Google what your content is about.

Without it, search engines can't confidently show your products in rich results (like pro

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/resin8-cannabis-products/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

The page about your Resin8 cannabis products is missing a meta description — the 155-character summary

that appears under your page title in Google search results. Without it, Google will auto-generat

[P2] No JSON-LD schema 🟠  HIGH

Your product pages don't include JSON-LD structured data — machine-readable code that tells Google what

your pages are about. Without it, search engines have to guess whether a page is a product listi

https://greenleafwellness.com/rove-cartridges/
https://greenleafwellness.com/binske-cannabis-products/
https://greenleafwellness.com/resin8-cannabis-products/


[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/how-much-is-an-ounce-of-weed/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page doesn't have a meta description — the 155-character summary that appears under the page title in

Google search results. Without it, Google generates a random excerpt from the page content, w

[P2] No JSON-LD schema 🟡  MEDIUM

Your product and informational pages don't include structured data — machine-readable code that tells Google

what your content is about. Without it, search engines have to guess whether a page is a pr

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/head-cheese-strain/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This product page (Head Cheese Strain) is missing a meta description — the 150-160 character summary that

appears below the page title in Google search results. Without it, Google auto-generates a sni

[P2] No JSON-LD schema 🟠  HIGH

Your product pages (like the Head Cheese strain page) are missing structured data — machine-readable code

that tells Google what type of content you're showing. Without it, search engines have to gues

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/packwoods-how-much-are-they-and-what-

are-they/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your product pages are missing structured data—machine-readable code that tells Google what your content is

about. Without it, search engines have to guess whether a page is about a product, a blog po

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-much-is-an-ounce-of-weed/
https://greenleafwellness.com/head-cheese-strain/
https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/
https://greenleafwellness.com/packwoods-how-much-are-they-and-what-are-they/


https://greenleafwellness.com/kosmik-edibles/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This product page (Kosmik Edibles) doesn't have a meta description — the 155-character summary that

appears under your page title in Google search results. Without it, Google generates a random snippe

[P2] No JSON-LD schema 🟠  HIGH

Your product pages are missing JSON-LD structured data—machine-readable code that tells search engines

what your products are, their prices, and ratings. Without it, Google has to guess what it's look

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/camp-cannabis/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your Camp Cannabis page is missing a meta description — the 160-character summary that appears below your

page title in Google search results. Without it, Google will auto-generate a snippet from your

[P2] No JSON-LD schema 🟠  HIGH

Your product pages are missing structured data — machine-readable code that tells Google what your products

are, their prices, and ratings. Without it, search results show plain text instead of rich c

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-

dont-have-to-dab/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page is missing a meta description — the 150–160 character summary that appears below the page title in

Google search results. Without it, Google may auto-generate a snippet from your page text,

[P2] No JSON-LD schema 🟠  HIGH

Your product and educational pages are missing structured data—machine-readable code that tells Google

what your content is about. Without it, search engines have to guess whether a page is a product,

[P3] Title length 83 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/kosmik-edibles/
https://greenleafwellness.com/camp-cannabis/
https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/
https://greenleafwellness.com/how-to-use-cannabis-concentrates-you-dont-have-to-dab/


https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page doesn't have a meta description — the 155-character summary that appears below the page title in

Google search results. Without it, Google will auto-generate a snippet from your page content

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/best-dispensaries-in-nevada-2023/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page doesn't have a meta description — the 160-character summary that appears under the page title in

Google search results. Without it, Google generates a random snippet from your page text, whi

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your article page about THC drinks doesn't include a meta description — the 155-character summary that

appears below your page title in Google search results. Without it, Google auto-generates text fr

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about THC drinks has no structured data—machine-readable code that tells Google what the

page is about. Search engines use this to understand content better and may display richer resul

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/nevada-weed-laws-for-tourists/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

https://greenleafwellness.com/best-flower-and-pre-rolls-in-nevada/
https://greenleafwellness.com/best-dispensaries-in-nevada-2023/
https://greenleafwellness.com/the-11-best-thc-drinks-in-nevada/
https://greenleafwellness.com/nevada-weed-laws-for-tourists/


Your blog post about Nevada weed laws has no structured data markup — machine-readable code that tells

Google what type of content it is (article, guide, FAQ, etc.). Without it, search engines have to

[P3] Title length 81 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/burning-man-closest-dispensary-to-the-

airport/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page is missing a meta description — the 155-character summary that appears below your page title in

Google search results. Without it, Google will auto-generate one from your page text, which is

[P2] No JSON-LD schema 🟡  MEDIUM

Your page doesn't include JSON-LD structured data — machine-readable code that tells Google what your

content is about. For a cannabis retail site, this means search engines can't reliably understand

[P3] Title length 94 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/are-edibles-legal-in-nevada/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your article page doesn't include JSON-LD structured data — machine-readable code that tells search engines

what your content is about. Google uses this to understand your page better and can display

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-

a-day-in-nevada/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

This blog post page has no meta description — the 160-character summary that appears below the page title in

Google search results. Without it, Google will auto-generate a snippet from page content, w

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about Nevada dispensary rules has no structured data markup—invisible labels that tell Google

what your content is about. Without it, search engines have to guess whether you're a news

https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/
https://greenleafwellness.com/burning-man-closest-dispensary-to-the-airport/
https://greenleafwellness.com/are-edibles-legal-in-nevada/
https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/
https://greenleafwellness.com/can-you-go-to-more-than-one-dispensary-a-day-in-nevada/


[P3] Title length 76 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 81 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/what-happens-if-you-get-caught-with-

weed-in-nevada/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-

in-one-visit/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 84 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/medical-marijuana-card-in-nevada/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/are-dispensaries-cash-only-in-nevada/
https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/
https://greenleafwellness.com/what-happens-if-you-get-caught-with-weed-in-nevada/
https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/
https://greenleafwellness.com/most-you-can-purchase-at-a-dispensary-in-one-visit/
https://greenleafwellness.com/medical-marijuana-card-in-nevada/


https://greenleafwellness.com/do-dispensaries-share-information-with-

the-government/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 85 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-bachelorette-party-guide/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 89 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-edibles-sparks/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 81 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 84 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/seasonal-cannabis-product-guide/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/
https://greenleafwellness.com/do-dispensaries-share-information-with-the-government/
https://greenleafwellness.com/cannabis-bachelorette-party-guide/
https://greenleafwellness.com/cannabis-edibles-sparks/
https://greenleafwellness.com/cannabis-and-rental-properties-in-nevada/
https://greenleafwellness.com/seasonal-cannabis-product-guide/


[P3] Title length 94 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/thc-edible-dosing-for-beginners/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 99 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-101-beginners-guide-reno-

nevada/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 81 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/understanding-thc-cbd-cannabis-

compounds-explained/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 84 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-terpene-guide-effects-

experience/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 91 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/thc-edible-dosing-for-beginners/
https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/
https://greenleafwellness.com/cannabis-101-beginners-guide-reno-nevada/
https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/
https://greenleafwellness.com/understanding-thc-cbd-cannabis-compounds-explained/
https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/
https://greenleafwellness.com/cannabis-terpene-guide-effects-experience/


https://greenleafwellness.com/cannabis-consumption-methods-finding-

what-works/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-

hybrids/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 76 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/endocannabinoid-system-how-cannabis-

works/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 80 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/indica-vs-sativa-effects/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 95 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/gorilla-glue-strain/

_5 findings on this page_

https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/
https://greenleafwellness.com/cannabis-consumption-methods-finding-what-works/
https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/
https://greenleafwellness.com/cannabis-strains-explained-indica-sativa-hybrids/
https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/
https://greenleafwellness.com/endocannabinoid-system-how-cannabis-works/
https://greenleafwellness.com/indica-vs-sativa-effects/
https://greenleafwellness.com/gorilla-glue-strain/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-long-do-edibles-last/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 88 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/medical-marijuana-dispensaries/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 89 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-much-is-an-eighth/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 81 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/the-dispensary-reno/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 92 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-long-do-edibles-last/
https://greenleafwellness.com/medical-marijuana-dispensaries/
https://greenleafwellness.com/how-much-is-an-eighth/
https://greenleafwellness.com/the-dispensary-reno/


https://greenleafwellness.com/cannabis-dispensary-near-me/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/what-is-live-rosin/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 68 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/what-is-bho/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/best-cannabis-strains-for-beginners/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 74 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-to-get-medical-card/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 80 chars

[P3] Missing OpenGraph metadata

https://greenleafwellness.com/cannabis-dispensary-near-me/
https://greenleafwellness.com/what-is-live-rosin/
https://greenleafwellness.com/what-is-bho/
https://greenleafwellness.com/best-cannabis-strains-for-beginners/
https://greenleafwellness.com/how-to-get-medical-card/


[P3] Missing Twitter card

https://greenleafwellness.com/what-is-a-dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 91 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/wax-vs-shatter/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 92 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/best-way-to-smoke-wax/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 85 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-long-should-a-1-g-cart-last/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cbn-for-sleep/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

https://greenleafwellness.com/what-is-a-dispensary/
https://greenleafwellness.com/wax-vs-shatter/
https://greenleafwellness.com/best-way-to-smoke-wax/
https://greenleafwellness.com/how-long-should-a-1-g-cart-last/
https://greenleafwellness.com/cbn-for-sleep/


[P3] Title length 68 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/thc-and-migraines/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 67 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/does-cannabis-affect-antibiotics/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 74 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/does-thc-affect-antibiotics/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/what-is-cbd-vs-thc/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 83 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/difference-between-indica-sativa/

_5 findings on this page_

https://greenleafwellness.com/thc-and-migraines/
https://greenleafwellness.com/does-cannabis-affect-antibiotics/
https://greenleafwellness.com/does-thc-affect-antibiotics/
https://greenleafwellness.com/what-is-cbd-vs-thc/
https://greenleafwellness.com/difference-between-indica-sativa/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 96 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-for-anxiety-treatment/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 91 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/best-indica-strains-for-sleep/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 92 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/glitter-bomb-strain/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 97 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-for-anxiety-treatment/
https://greenleafwellness.com/best-indica-strains-for-sleep/
https://greenleafwellness.com/glitter-bomb-strain/
https://greenleafwellness.com/sativa-vs-indica-vs-hybrid/


https://greenleafwellness.com/what-is-delta-8-vs-delta-9/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 92 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-strains-for-anxiety/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/best-edible-dosage-calculator/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 76 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/best-cannabis-storage-containers/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-to-roll-a-joint/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 71 chars

[P3] Missing OpenGraph metadata

https://greenleafwellness.com/what-is-delta-8-vs-delta-9/
https://greenleafwellness.com/cannabis-strains-for-anxiety/
https://greenleafwellness.com/best-edible-dosage-calculator/
https://greenleafwellness.com/best-cannabis-storage-containers/
https://greenleafwellness.com/how-to-roll-a-joint/


[P3] Missing Twitter card

https://greenleafwellness.com/packing-a-bowl/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-to-decarb-weed/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/weed-strains-for-anxiety/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 70 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-to-properly-smoke/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

https://greenleafwellness.com/packing-a-bowl/
https://greenleafwellness.com/how-to-decarb-weed/
https://greenleafwellness.com/weed-strains-for-anxiety/
https://greenleafwellness.com/how-to-properly-smoke/
https://greenleafwellness.com/blue-dream-strain-sativa-or-indica/


[P3] Title length 76 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 76 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/does-indica-make-you-hungry/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 91 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/good-strains-for-adhd/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 73 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/blog/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/old-rewards-menu/

_5 findings on this page_

https://greenleafwellness.com/how-many-grams-is-an-1-8-of-weed/
https://greenleafwellness.com/does-indica-make-you-hungry/
https://greenleafwellness.com/good-strains-for-adhd/
https://greenleafwellness.com/blog/
https://greenleafwellness.com/old-rewards-menu/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/shop-delivery/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/recreational/marijuana-dispensary-near-

reno-nv-89502/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-

tahoe-ca-96145/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 74 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-

mccarran-nv-89434/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 77 chars

https://greenleafwellness.com/shop-delivery/
https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-near-reno-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-tahoe-ca-96145/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-mccarran-nv-89434/


[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-

spanish-springs-nv-89436/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 84 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-

hidden-valley-nv-89502/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 82 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-

sun-valley-nv-89433/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 79 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-

virginia-city-nv-89440/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 82 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-spanish-springs-nv-89436/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-hidden-valley-nv-89502/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-sun-valley-nv-89433/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-virginia-city-nv-89440/


https://greenleafwellness.com/recreational/the-best-casinos-near-reno-

nv-are-close-to-our-dispensary/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 86 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-concentrates/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-

carson-city-nv/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 80 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/marijuana-dispensary-serving-

fallon-nv-89406/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 75 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brands/

_5 findings on this page_

https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/recreational/the-best-casinos-near-reno-nv-are-close-to-our-dispensary/
https://greenleafwellness.com/cannabis-concentrates/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-carson-city-nv/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/
https://greenleafwellness.com/recreational/marijuana-dispensary-serving-fallon-nv-89406/
https://greenleafwellness.com/brands/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 3 image(s) missing alt text

https://greenleafwellness.com/ios-app-android-app/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 4 image(s) missing alt text

https://greenleafwellness.com/deals-discounts/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 2 image(s) missing alt text

https://greenleafwellness.com/budtender/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/recreational/dispensary-near-midtown-

reno/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 67 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/ios-app-android-app/
https://greenleafwellness.com/deals-discounts/
https://greenleafwellness.com/budtender/
https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/
https://greenleafwellness.com/recreational/dispensary-near-midtown-reno/


https://greenleafwellness.com/recreational/dispensary-near-spanish-

springs/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 72 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/dispensary-near-sparks-

marina/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 69 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/rove-cartridges/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/brand/resin8/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/brand/binske-cannabis-products/

_5 findings on this page_

[P2] Missing meta description

https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/
https://greenleafwellness.com/recreational/dispensary-near-spanish-springs/
https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/
https://greenleafwellness.com/recreational/dispensary-near-sparks-marina/
https://greenleafwellness.com/brand/rove-cartridges/
https://greenleafwellness.com/brand/resin8/
https://greenleafwellness.com/brand/binske-cannabis-products/


[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/brand/packwoods/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Title length 77 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/kosmik-edibles/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/brand/camp-cannabis/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/brand/srene-cannabis/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/brand/matrix-nv/

https://greenleafwellness.com/brand/packwoods/
https://greenleafwellness.com/brand/kosmik-edibles/
https://greenleafwellness.com/brand/camp-cannabis/
https://greenleafwellness.com/brand/srene-cannabis/
https://greenleafwellness.com/brand/matrix-nv/


_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/brand/green-leaf-productions/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/brand/polaris-cannabis/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://greenleafwellness.com/category/uncategorized/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/category/education/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/green-leaf-productions/
https://greenleafwellness.com/brand/polaris-cannabis/
https://greenleafwellness.com/category/uncategorized/
https://greenleafwellness.com/category/education/


https://greenleafwellness.com/category/products-brands/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/category/strains/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/category/events/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/author/andrewlz/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/author/cannaplanners/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

https://greenleafwellness.com/category/products-brands/
https://greenleafwellness.com/category/strains/
https://greenleafwellness.com/category/events/
https://greenleafwellness.com/author/andrewlz/
https://greenleafwellness.com/author/cannaplanners/


[P3] Missing Twitter card

https://greenleafwellness.com/author/jhammer/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/author/slash/

_5 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page doesn't have a meta description — the 150-160 character summary that appears below your page

title in Google search results. Without it, Google generates a random excerpt from your page cont

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/bubba-fett-strain/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This product page (Bubba Fett strain) is missing a meta description — the 160-character snippet that appears

below your page title in Google search results. Without it, Google generates a random excer

[P2] No JSON-LD schema 🟠  HIGH

Your product pages don't include JSON-LD schema markup—a machine-readable format that tells Google what

your content is about. This means search engines have to guess whether your page is about a prod

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/author/jhammer/
https://greenleafwellness.com/author/slash/
https://greenleafwellness.com/first-time-visiting-a-dispensary-in-nevada/
https://greenleafwellness.com/bubba-fett-strain/


https://greenleafwellness.com/slurricane-strain/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your product pages (like the Slurricane Strain page) are missing structured data — machine-readable labels that

tell Google what kind of content you're showing. Without it, search engines have to gues

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/stiiizy-carts-and-flower/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your product page for Stiiizy carts doesn't have a meta description—that's the 160-character preview snippet

that appears under your link in Google search results. Without it, Google generates a rando

[P2] No JSON-LD schema 🟠  HIGH

Your product pages don't include JSON-LD structured data—machine-readable code that tells Google what

your products are, their prices, and availability. Without it, search engines have to guess what's

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/marys-medicinals/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your product pages are missing JSON-LD structured data — a machine-readable format that tells Google what

your page is about (e.g., product name, price, availability). Without it, search engines have

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabiotix-cbx-products/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This product page is missing a meta description — the 160-character text snippet that appears below your page

title in Google search results. Without it, Google generates a generic excerpt from your p

[P2] No JSON-LD schema 🟠  HIGH

Your product pages don't include JSON-LD structured data — machine-readable code that tells Google what

your page is about (e.g., product name, price, availability). Without it, search engines have to

https://greenleafwellness.com/slurricane-strain/
https://greenleafwellness.com/stiiizy-carts-and-flower/
https://greenleafwellness.com/marys-medicinals/
https://greenleafwellness.com/cannabiotix-cbx-products/


[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/mojave-flower/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your product page for Mojave Flower is missing a meta description — the 155-character summary that appears

below the page title in Google search results. Without it, Google generates a random snippet

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/aether-gardens/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟡  MEDIUM

Your product pages (like the Aether Gardens page) don't include JSON-LD structured data — a machine-

readable format that tells search engines what content is on the page. Without it, Google can't conf

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/best-discreet-vape-pens/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your product page about vape pens doesn't have a meta description — the 160-character summary that

appears below your page title in Google search results. Without it, Google generates a random snippet

[P2] No JSON-LD schema 🟠  HIGH

Your product pages are missing JSON-LD structured data — machine-readable code that tells Google what your

pages are about. Without it, search engines can't easily understand your product details, pri

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/kuno-cannabis/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This product page is missing a meta description — the 150–160 character summary that appears under your

page title in Google search results. Without it, Google will auto-generate a snippet from your p

https://greenleafwellness.com/mojave-flower/
https://greenleafwellness.com/aether-gardens/
https://greenleafwellness.com/best-discreet-vape-pens/
https://greenleafwellness.com/kuno-cannabis/


[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/srene-cannabis/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page about live resin, rosin, and badder doesn't have a meta description — the 150-160 character summary

that appears under the page title in Google search results. Without it, Google generates o

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about live resin, rosin, and badder has no structured data markup—essentially machine-readable

labels that tell Google what the page is about. Search engines use this to understand cont

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page is missing a meta description — the 155-character summary that appears under your page title in

Google search results. Without it, Google will auto-generate a snippet from your page content,

[P2] No JSON-LD schema 🟡  MEDIUM

Your website isn't using JSON-LD structured data — a standardized format that tells Google what your content

is about (e.g., a product, a business location, an article). Without it, search engines hav

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/top-7-best-edibles-in-nevada/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

https://greenleafwellness.com/srene-cannabis/
https://greenleafwellness.com/live-resin-vs-rosin-vs-badder/
https://greenleafwellness.com/ski-resorts-near-reno-nv-and-tahoe-ca/
https://greenleafwellness.com/top-7-best-edibles-in-nevada/


The page about edibles in Nevada doesn't have a meta description — a 155-character summary that appears

under the page title in Google search results. Without it, Google generates a random snippet fro

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about edibles in Nevada has no structured data — machine-readable labels that tell Google what

the page is about. Think of it like the difference between a shelf with organized product

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-

nevada/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your blog post about cannabis concentrates doesn't have a meta description — the short text snippet (usually

150–160 characters) that appears below your page title in Google search results. Without it

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/

_4 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your blog post about vape carts in Nevada doesn't have a meta description — that's the 155-character summary

that appears under your page title in Google search results. Without it, Google generates a

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog post about vape carts has no structured data—machine-readable code that tells Google what type of

content this is (a review, article, product listing, etc.). Without it, search engines have

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/nugget-rib-cook-off-2023/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/

https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/
https://greenleafwellness.com/top-7-best-cannabis-concentrates-in-nevada/
https://greenleafwellness.com/top-7-best-vape-carts-in-nevada/
https://greenleafwellness.com/nugget-rib-cook-off-2023/
https://greenleafwellness.com/things-to-do-in-reno-nevada-2023/


_4 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your blog post about things to do in Reno doesn't include a meta description — the 155-character summary that

appears below the page title in Google search results. Without it, Google generates a rand

[P2] No JSON-LD schema 🟠  HIGH

Your blog post about things to do in Reno doesn't have structured data—a special code block that tells Google

what your content is about. Without it, search engines have to guess whether you're writin

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/reno-weed-culture/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/best-dispensary-near-me/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-to-inhale-weed-properly/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/reno-weed-culture/
https://greenleafwellness.com/why-do-dispensaries-scan-id-in-nevada/
https://greenleafwellness.com/best-dispensary-near-me/
https://greenleafwellness.com/how-to-inhale-weed-properly/


https://greenleafwellness.com/nevada/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/bruce-banner-strain/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/where-can-i-get-my-medical-card/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/how-to-make-cannabutter/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/what-strain-is-blue-dream/

_4 findings on this page_

https://greenleafwellness.com/nevada/
https://greenleafwellness.com/bruce-banner-strain/
https://greenleafwellness.com/your-guide-to-the-sour-haze-strain/
https://greenleafwellness.com/where-can-i-get-my-medical-card/
https://greenleafwellness.com/how-to-make-cannabutter/
https://greenleafwellness.com/what-strain-is-blue-dream/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/contact/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/module-list/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/about/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/policies/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/faq/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

https://greenleafwellness.com/contact/
https://greenleafwellness.com/module-list/
https://greenleafwellness.com/about/
https://greenleafwellness.com/policies/
https://greenleafwellness.com/faq/


[P3] Missing Twitter card

https://greenleafwellness.com/recreational/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-flower/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-vapes-and-carts/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/cannabis-edibles/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/pre-rolls/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/recreational/
https://greenleafwellness.com/cannabis-flower/
https://greenleafwellness.com/cannabis-vapes-and-carts/
https://greenleafwellness.com/cannabis-edibles/
https://greenleafwellness.com/pre-rolls/


https://greenleafwellness.com/cannabis-beverages-thc-drinks/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/wyld-gummies/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/stiiizy/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/marys-medicinals/

_4 findings on this page_

https://greenleafwellness.com/cannabis-beverages-thc-drinks/
https://greenleafwellness.com/buy-cannabis-concentrates-reno-nv/
https://greenleafwellness.com/deals-discounts/420-deals-sparks-reno-nv/
https://greenleafwellness.com/brand/wyld-gummies/
https://greenleafwellness.com/brand/stiiizy/
https://greenleafwellness.com/brand/marys-medicinals/


[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/cannabiotix/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/mojave-flower/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/aether-gardens/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/kuno-cannabis/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/nlvo/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

https://greenleafwellness.com/brand/cannabiotix/
https://greenleafwellness.com/brand/mojave-flower/
https://greenleafwellness.com/brand/aether-gardens/
https://greenleafwellness.com/brand/kuno-cannabis/
https://greenleafwellness.com/brand/nlvo/


[P3] Missing Twitter card

https://greenleafwellness.com/brand/sip-elixirs/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/vert-unlimited/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/vada-cannabis/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/brand/the-real-mccoy-cannabis/

_4 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://greenleafwellness.com/wp-login.php

_1 finding on this page_

[P0] Sensitive artifact exposed: /wp-login.php 🔴  DO FIRST

Your WordPress login page (/wp-login.php) is publicly accessible and returns a successful response. This is a

standard WordPress file, but leaving it exposed makes your site an easy target for automat

https://greenleafwellness.com/brand/sip-elixirs/
https://greenleafwellness.com/brand/vert-unlimited/
https://greenleafwellness.com/brand/vada-cannabis/
https://greenleafwellness.com/brand/the-real-mccoy-cannabis/
https://greenleafwellness.com/wp-login.php
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